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Introducing  
 Translate 2004  

The LEC Translate system can simplify all of your translation tasks. Whether you want to 
understand a document or web page better, exchange messages with someone who writes in a 
different language, or translate an entire folder of documents, Translate will provide the best 
desktop translation.  

To use Translate, you’ll want to become familiar with these components:  

Desktop Translation Tools 

The full version of Translate includes four translation applications that share the same dictionaries 
and translation languages but are designed for different translation situations and working styles.  

LogoTrans 

LogoTrans is the easiest translation application to use for typing and translating small 
amounts of text. Its two panes show both the original text and the translation. Use it to get a 
quick translation of a few sentences while doing other work. LogoTrans can open and 
translate plain text documents as well as print and save translations. 

Turn to LogoTrans when you’re reading a foreign document onscreen and want help 
understanding a sentence or paragraph. 

For complete instructions on using LogoTrans, refer to the topic LogoTrans: Translating 
for Quick Understanding. 

TransIt 

TransIt is designed to translate a word, phrase, or sentence and effortlessly place it into your 
primary text application. TransIt lets you chat or instant message back and forth with a 
correspondent who uses a different language. You can easily translate your message into 
your correspondent’s language before sending. When you receive a reply, you can quickly 
view its translation in your own language. These features make TransIt the best tool for 
two-way conversations that you don’t intend to save. 

For complete instructions on using TransIt, refer to the topic TransIt: Translating Short 
Expressions. 
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Translation Mirror 

Translation Mirror can monitor a window in another text-based application and 
automatically translate any text that appears in it. 

For complete instructions on using Translation Mirror, refer to the topic Translation Mirror: 
Monitoring and Translating Text from Another Application.. 

FileTrans 

FileTrans is a tool for translating entire text documents. It translates whatever you give it—
one document or an entire multi-level directory of documents—working in the background 
so that you and your computer are free to work on other tasks.  

Use FileTrans whenever you have a large number of files to translate, including directories 
of text or HTML files. 

For complete instructions on using FileTrans, refer to the topic FileTrans: Translating Files 
in the Background. 

Dictionary Browser  

Dictionary Browser is the application you use to browse the contents of LEC’s electronic 
dictionaries and look up specific words and phrases. For language pairs that support user 
dictionaries, Dictionary Browser also lets you create your own dictionaries and edit their 
contents. 

You can open Dictionary Browser from within translation applications as well as from the 
Windows Start menu or desktop. 

For complete instructions on using Dictionary Browser, refer to the topic Working With 
Dictionaries. 

Add-Ins for Translating in Other Applications 

These components bring the power of desktop translation directly into your Microsoft® 
Word, Excel, and PowerPoint documents as well as into Web pages you are viewing with 
Microsoft Internet Explorer. 

Microsoft Word, Excel, and PowerPointl Add-Ins 

These small programs add commands to Microsoft Word, Excel, and PowerPoint to let you 
translate either an entire document or text you have selected, directly in the Word, Excel, or 
PowerPoint document window.  
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Background Components 

These components do their work unseen in the background.  

Translation Engines 

In the background, translation engines perform the actual work of translating. Whenever 
possible, they work with an entire sentence at a time. They parse each sentence into its 
component parts, determine the part of speech of each word and the function of each phrase, 
and then look up the translation of the words and phrases in software dictionaries. 

Each engine is represented by a pair of translation languages; for example, E>S for 
translating from English to Spanish, and the S>E for translating from Spanish to English. 
Each pair of translation languages works with all the translation applications.   

The full version of Translate can provide direct translation between 240 language pairs. The 
product you purchased probably contains a subset of these languages: 

 

Language Pair Symbol Language Pair Symbol 

English to Arabic En¾Ar Arabic to English Ar¾En 

English to Chinese En¾Ch Chinese to English  Ch¾En 

English to French En¾Fr French to English  F¾En 

English to German En¾Ge German to English  Ge¾En 

English to Hebrew En¾He Hebrew to English He¾En 

English to Italian En¾It Italian to English  It¾En 

English to Japanese En¾Ja Japanese to English Ja¾En 

English to Korean  En¾Ko Korean to English Ko¾En 

English to Persian En¾Pe Persian to English Pe¾En 

English to Polish En¾Po Polish to English  Po¾En 

English to Portuguese En¾Pt Portuguese to English  Pt¾En 

English to Russian En¾Ru Russian to English Ru¾En 

English to Spanish  En¾Sp Spanish to English Sp¾En 

English to Turkish En¾Tr Turkish to English Tr¾En 

English to Ukrainian En¾Uk Ukrainian to English Uk¾En 

If you want to supplement the languages in the package you purchased, you can obtain any 
of these translation languages from LEC or your LEC dealer. 
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Electronic Dictionaries 

A LEC dictionary accompanies each language pair. This large “main dictionary” contains 
tens of thousands of entries for many idiomatic phrases as well as individual words. To 
provide the most accurate translation, each main dictionary classifies words according to 
complex rules and utilizes many more parts of speech than the standard rules of grammar 
provide.  

You can supplement some language pairs with one or more technical dictionaries, 
containing the translation of terms in specialized fields such as business, medicine, or 
engineering. You can purchase technical dictionaries from LEC or your LEC dealer. In 
addition, most language pairs let you supplement the LEC dictionary with user dictionaries 
which you create and modify yourself. For complete instructions on working with 
dictionaries, refer to the topic Working With Dictionaries. 
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Tips for Getting the Best 
Translations 

Computer translation has improved tremendously in recent years, and LEC provides the highest 
quality desktop translation available anywhere. Still, when it comes to understanding language, 
computers lack many skills that people use automatically. Computers do not know about the social 
context in which language is used and cannot take that into account. They cannot consider 
complexities of subject matter or emotional nuances that affect the meaning of a sentence. 
Computers also stumble over misspellings, ideas left inexplicit because the writer knows that 
readers will assume them, and words used in a “poetic” rather than literal sense. 

For all these reasons, a little extra care when writing text for translation can make a tremendous 
difference in the accuracy of your results.  

Write Explicitly 

Do not omit important words (for example relative clause pronouns such as that, which, who, and 
whom) or phrases. Avoid unclear references such as pronouns that refer to things which are not 
clearly identified in the sentence. 

Like this: I know that the fax machine worked yesterday. 

Not Like This: I know the fax worked yesterday. 

Write Clearly and Simply 

Aiming for simple, direct language that is easily understood will lead to better translations than 
aiming for colorful language or for a unique style. Avoid using slang, unusual expressions, or 
infrequently encountered words which may not be included in Translate’s dictionaries. Avoid 
words or phrases that can have more than one meaning. 

Like this: Both people felt nervous after the brief silence. 

Not Like This: A pregnant pause ushered in a tense hiatus in the conversation. 

Be Concise 

Brief sentences translate better. As a rule of thumb, limit sentences to between 15 and 20 words. 
Break long and complex sentences into shorter and simpler sentences. Revise awkward sentences 
to make them clearer and more concise. 

Like this: When confronted with a sentence that has many long clauses, divide it into two or more 
sentences. Each sentence should be no longer than 20 words. Make sure that the sentence contains 
all of the elements that correct grammar requires. 
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Not Like This: When confronted with a sentence that has many long clauses, be sure that you 
divide it into two or more sentences, each of which should be no longer than 20 words, but 
whatever you do, make sure that the sentence contains all the elements which are required by 
correct grammar. 

Use Proper Grammar and Spelling 

Complete sentences translate much better than single words or short phrases. Well-organized and 
well-constructed sentences translate much better than poorly structured ones.  

Make sure to use proper spelling. Although Translate’s dictionaries include common misspellings 
and alternate spellings for words, Translate can not interpret many misspelled words.  

Because Translate uses spacing and punctuation marks to find the beginning and end of sentences, 
be sure to use spacing and punctuation properly. For example, use question marks for questions 
and periods at the end of declarative sentences. 

Additional Tips 

Here are some more tips to help you generate more accurate results with Translate. 

1. Write your documents in standard, formal language. 

Aim for clear, formal writing, which is easiest for your reader to understand -- the kind 
of writing you would use in a business letter. Informal language -- the way you would 
speak in a conversation -- does not follow grammatical rules as closely and does not 
result in the best translations.  

2. Avoid figures of speech. 

Figures of speech, also called idioms or metaphorical expressions, frequently do not 
translate well. When translated literally, the words in a different language may have a 
completely different meaning from what you intend. 

Like this: His presentation was a big success. 

Not Like This: He hit a home run with his presentation. 

3. Use a pronoun before each verb. 

In many languages, the form of a verb depends upon the gender and number of the 
pronoun that precedes it. 

Like this: I saw that movie, but I did not like it. 

Not Like This: I saw that movie but did not like it. 

4. Do not split compound verbs, such as ‘pick up’ and ‘look up’. 

Like this: I will have to look up the time of our appointment. 

Not Like This: I have to look the time of our appointment up. 
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5. Clearly indicate the beginning and end of each sentence.  

A hard return is interpreted as the end of the sentence, so remove any return characters 
from the middle of sentences. (Email messages frequently have a return character at the 
end of each line.)  

Make headings explicit, for example by capitalizing the first letter of each word or by 
ending the heading with a period, return character, or blank line. If the document 
contains numbered or bulleted lists, consider making each one into a complete sentence, 
especially if they do not translate well. 
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Getting Started With 
Translate  

Use these instructions to get started making your first translations and to become familiar with 
Translate basics. Please refer to the other sections of this user guide for complete instructions for 
using each of the Translate components.  

To open a translation tool 

Click the Windows Start menu located in the corner of your screen; in the menu, click 
Programs, then Language Engineering, and then choose the component from the Language 
Engineering sub-menu. You can use the Start menu to open Dictionary Browser, LogoTrans, 
TransIt, FileTrans, and Translation Mirror as well. 

To make your first translation 

If you’re new to Translate, we recommend that you start with LogoTrans. LogoTrans 
displays both your source text and the translation so you can compare them, lets you save 
the translation, and also lets you print the source text or translation. 

1. Double-click the LogoTrans icon on your desktop. 

LogoTrans opens. Notice that the window has two panes. The upper pane is for the 
source text, the lower for the translation. 

A button in the lower right corner of the window shows which translation language is 
selected and the direction of translation; for example, En>Fr is for translating English 
to French. 

 The same button appears in all the Translate tools. 

2. Click the translation languages button to open a menu of all the installed 
languages and choose the one you want. 

3. To translate, just type a small amount of text into the upper pane. 

When you pause in typing, LogoTrans begins translating the text and almost 
immediately displays the translation in the lower pane. 

Tip: Complete sentences translate better than single words or short phrases. 

If untranslated words appear in the lower pane, it means that no translation for that 
expression could be found in Translate’s dictionaries. If none of the text is translated, 
make sure you have selected the proper translation language. You can edit the text in 
the upper pane to improve the translation. Whenever you revise the source text, it is 
retranslated. 
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For complete instructions on using LogoTrans, refer to the topic LogoTrans: 
Translating for Quick Understanding or open online help for LogoTrans by pressing 
F1 on your keyboard. 

To move text between applications 

You may want to translate text that was created in another application, such as word 
processing or email software. That requires you to move the text from the original 
application to the translation tool. After the text is translated, you may want to move the 
translation back to the original application for saving or editing. 

You can set LogoTrans to read and translate any text you cut or copy in another application, 
and TransIt can insert a translation directly into many applications. You can set Translation 
Mirror to monitor the document window of another application and automatically translate 
whatever text appears there. In other situations, or with applications in which these 
techniques do not work, you will need to move the text using your mouse. To do that, 
follow the steps below: 

1. Select the text you want to move.  

Here’s how: Move the mouse pointer to the beginning of the text. Press and hold the 
left mouse button down while you drag the pointer to the end of the text; then release 
the mouse button. The selected text is highlighted. 

When you want to select all the text in a window, you can also click anywhere inside 
the window and choose Select All from the application’s Edit menu. 

2. Try dragging and dropping 

Most modern applications let you move text by dragging it and dropping it in the 
desired location. Here’s how: Point to the highlighted text, press and hold the left 
mouse button down while you drag the pointer to the desired location; then release the 
mouse button. 

3. If drag and drop doesn’t work, copy and paste the selected text.  

Here’s how: After selecting the text, choose Copy from the Edit menu of your 
translation tool, click in the location where you want to place the text, and then choose 
Paste from the Edit menu of that application. 

To choose these commands in TransIt, click the menu icon in the TransIt window and 
on the menu that opens click Edit, then choose from the sub-menu. 
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To translate a file with LogoTrans 

Although not recommended for translating more than a few pages, LogoTrans can open and 
translate a small document that consists of plain text, such as documents created with 
Notepad or documents created with commercial word processing applications and then 
saved as plain text.  

1. Save the document as plain text.  

If the file was created with word-processing software such as Word, it was probably 
saved in a proprietary format. To translate it with LogoTrans you must first save it as 
plain text. Here’s how: Open the file in the application used to create it. Choose Save 
As from the File menu. In the dialog box, give the file a new name, ending with the 
extension .txt. From the ‘Save as type’ menu in the dialog box, choose Text Only. 
(Your application may use a different term, such as Plain Text, or just Text.) If you like, 
select a different folder location for the file and then click Save. 

Note that saving a file as plain text does not preserve any special formatting, such as 
headers and footers or character and paragraph styles. 

2. Close the document. 

Your document cannot be open in LogoTrans and another application at the same time. 

3. Open LogoTrans and from the File menu, choose Load Source. 

4. In the dialog box, locate and select the text file you want to translate, and click 
Open.  

The text appears in the upper pane of the LogoTrans window. LogoTrans begins the 
translation immediately and displays it in the lower pane. 

Note: If the Word and Excel Add-Ins are installed on your computer, you can also 
translate documents created with either of these applications directly from the 
application. For more information, see the section of the user guide Translating To and 
From Other Applications.  

To translate a file with FileTrans 

FileTrans is the recommended tool for translating large documents. FileTrans can translate 
two types of documents in the background and save the translation in a new file. The 
document may consist of plain text, such as documents created with Notepad or documents 
created with commercial word processing applications and then saved as plain text. The 
document may also contain HTML tags, such as a web page saved with the extension .htm 
or .html. 

1. Save the original document as plain text or HTML.  

If the file was created with word-processing software such as Word, it was probably 
saved originally in a proprietary format. To translate it with FileTrans you must first 
save it as plain text. Here’s how: Open the file in the application used to create it. 
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Choose Save As from the File menu. In the dialog box, give the file a new name, 
ending with the extension .txt. From the ‘Save as type’ menu, choose Text Only. (Your 
application may use a different term, such as Plain Text, or just Text.) If you like, 
select a different folder location for the file and then click Save. 

If you save the file from a web browser, or from an application, such as Word, which 
can read HTML, save it as plain text or as a web page. Saving as text preserves only 
the text. Saving as a web page also preserves the HTML tags which provide special 
formatting. These tags will be preserved in the translation as well. The file name should 
have the extension .txt, .htm, or .html.  

2. Close the document after saving it. 

Your document cannot be open in FileTrans and another application at the same time. 

3. Open FileTrans and in the window, click the Translate button. 

4. In the dialog box, locate and select the file you want to translate, and click Open.  

FileTrans begins translating the file. Messages in the FileTrans window show how the 
translation is progressing. When the translation is complete, FileTrans saves it in the 
same folder as the original file, with ‘Translation of ...’ added to the name.  

There is an option which lets you view the file as soon as it is translated. Before 
translating the file, click Options in the FileTrans window. Then click the 
Miscellaneous tab, and make sure the box called ‘Open translated file when finished’ is 
checked. 

To print the text 

Use LogoTrans when you want to print a small amount of text.  

� From the LogoTrans File menu, choose Print  

Note: When you want to print the translation of an entire document that you translated 
with FileTrans, you may find it more convenient to open and print the document in a 
text-processing application such as Word or Notepad. 

To save a translation 

Use LogoTrans when you want to save a translation.  

� From the LogoTrans File menu, choose Save As. 

Note: When you translate an entire document with FileTrans, the translation is 
automatically saved in a new file. You can also save translations made with Translation 
Mirror. For more information please refer to the sections FileTrans: Translating Files 
in the Background and Translation Mirror: Monitoring and Translating Text From 
Another Application. 
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To edit a translation 

TransIt is the only LEC translation tool in which you can edit the text of the translation 
directly. You can insert or delete characters the same way that you would edit text in a 
word-processing application.  

When using LogoTrans or Translation Mirror, we recommend using either of the following 
methods: 

z Copy the translation and paste the text into a word-processing application in which 
you can edit it. Here’s how: Click inside the translation and choose Select All from 
the Edit menu, then choose Copy from the Edit menu. Open your word processor, 
open a new document, and choose Paste from the Edit menu of your word processor. 

z Save the translation as a file, open your word processor, choose Open from the File 
menu, and open the saved file in your word processor. Tip: To make sure the file is 
visible in the Open dialog box, be sure to set the ‘Files of type’ drop-down menu to 
show all files. 
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Obtaining Help in Using 
Translate 

In addition to this user guide, Translate provides complete online help for each of its components. 

To view online help 

For information about the active window or dialog box and the tasks you can perform there, 
press F1 on your keyboard while using any Translate component. 

To identify objects and commands onscreen 

When using a translation application, which displays a window onscreen, you can display 
information about an object in the window. 

� Point to the object.  

After a moment, a tool tip near the pointer identifies the object or describes how you 
can use it. 

If the translation application has a status bar at the bottom of the window, it displays 
information about the currently selected command and any activity that is currently in 
progress. If no status bar is visible, it may be hidden. Look for a check box among the 
optional settings or a menu command that lets you show or hide the status bar. 

For up to date information and technical support 

For up-to-date information about LEC products, visit http://store.yahoo.com/logomedia-software/. 

Support is available by emailing info@lec.comt. So we can best assist you, please let us know: 

z Which Operating System do you have (for example Windows 95, Windows 98, Windows NT, 
Windows ME, Windows 2000, Windows XP, other)? Please note that Translate does not work 
with Windows 95. 

z Which LEC package did you purchase? 

z Where did you purchase the package? 

z How much memory (RAM) does your computer have (for example, 128K, 256K)? 

z How much free hard disk space do you have on your computer? 

z Which Translate component were you using (for example, LogoTrans) and if you were 
translating, from and to which languages? 

z If you got an error message, could you please copy and include its text?  
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z What steps were you following when the problem occurred or the error message appeared? 

z If you were using another text application with Translate, which one? 
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Selecting Languages 

Setting the Languages of the Source Text and 
Translation 

The full version of Translate can provide direct translation between 240 language pairs. The 
product you purchased probably contains a subset of these languages: 

 

Language Pair Symbol Language Pair Symbol 

English to Arabic En¾Ar Arabic to English Ar¾En 

English to Chinese En¾Ch Chinese to English  Ch¾En 

English to French En¾Fr French to English  F¾En 

English to German En¾Ge German to English  Ge¾En 

English to Hebrew En¾He Hebrew to English He¾En 

English to Italian En¾It Italian to English  It¾En 

English to Japanese En¾Ja Japanese to English Ja¾En 

English to Korean  En¾Ko Korean to English Ko¾En 

English to Persian En¾Pe Persian to English Pe¾En 

English to Polish En¾Po Polish to English  Po¾En 

English to Portuguese En¾Pt Portuguese to English  Pt¾En 

English to Russian En¾Ru Russian to English Ru¾En 

English to Spanish  En¾Sp Spanish to English Sp¾En 

English to Turkish En¾Tr Turkish to English Tr¾En 

English to Ukrainian En¾Uk Ukrainian to English Uk¾En 

 

To set the languages of the source text and translation 

You must set the language pair in each translation application. 

1. Open the translation application you want to use. 

Double-click the application’s icon on the Windows diesktop or in the Windows Start 
menu, look for LogoTrans, TransIt, or FileTrans under Programs/Language 
Engineering. 
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In the application window, the translation languages button shows the pair of languages 
that is currently selected and their direction. For example, English to French translation 
appears as En¾Fr. 

 

2. Click the translation languages button and choose the new languages from the 
menu that appears.  

Your choice remains in effect until you change it. 

3. If you want to select options for the translation languages, click the button again 
and choose Translation Options from the menu. 

The options editor appears, and you can change the settings. Different options are 
available for each pair of translation languages. They might include which dictionaries 
to use, the balance between translation speed and accuracy, and how to interpret the 
source text. For more information, refer to the topic Selecting Translation Options or 
press the F1 key on your keyboard after opening the options editor to display online 
help. 

Controlling the language pairs that are shown 

Clicking on the Translation Languages Button brings up a menu letting you choose a 
different translation language. This menu is a simple listing of language pairs if you 
have chosen a limited subset of the possible language pairs. If you chosen to display 
all or most of the possible language pairs, the language pairs will be sorted by source 
language. You can control the contents of this menu as shown in the Options dialog 
below. 
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The Language Pairs panel lets you choose what translation pairs you wish to have 
displayed by the Translation Languages Button in the Status Bar of the application. 
You can choose to have all possible language pairs (which could be nearly 250) 
displayed, or prune the list to only display language pairs that contain a particular 
language, or select the exact list of language pairs you wish to have displayed. 

Changing Which Language is Displayed and How It 
Appears 

To set your keyboard for entering and editing text 

When your computer has been set up for keyboard entry in more than one language, an 
indicator should appear in the system tray on your desktop.  

 

The letters on the indicator shows which language is selected (‘EN’ stands for English). 
When you want to type in a language that uses a different input method, you can switch by 
clicking the indicator and choosing from the menu that pops up. 
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If the indicator does not appear, follow the steps below. 

1. From the Windows Start menu, choose Settings/Control Panel.  

The Control Panel window opens. 

2. Double-click the Keyboard Control Panel and in its window, click the Input 
locales tab.  

When more than one locale and keyboard layout appear in the Input Locales tab, a 
checkbox labeled ‘Enable indicator on taskbar’ appears at the bottom of the tab. 

3. Make sure a check mark appears in the ‘Enable indicator on taskbar’ checkbox. 

4. If you want to add an additional locale, click the Add button, select both the new 
language and keyboard layout in the dialog box, and then click OK to close the 
dialog box. 

5. Click OK. 

Note that the Input Locales tab also lets you create hot keys for switching between 
input methods. 
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To change the font and size of text 
 
You can customize the way the text and buttons on your application look like by choosing the type 
of font for the applications. The font settings you apply are universal for all the applications. 
  
The font setting window can be brought up from the "Options" menu and then clicking on the 
"Font" tab. The font window shows up as follows 
  

 
  
"Tahoma" is the default font for the applications. You can change the font face and also specify the 
font size for each language pack. In case your machine is configured to show the various regional 
fonts, then the "Install Missing Code Page" appears disabled as shown above (as in case of 
English). 
  
But if your machine is not configured to support regional languages, then as shown in the image 
below the "Install Missing Code Page" button appears enabled. 
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You can then click on the "Install Missing Code Page" button to open a further popup window 
where you can specify which regional languages your machine should support and then install that 
particular code page from your Window Installation CD. 
  
Once the code pages are installed, you can start using your own languages and fonts for the 
applications. 

Setting Up Windows for Additional Languages 

Adding support for additional languages within your computer’s Windows settings may be 
required to display and enter text in those languages. Language support is built-in to many systems 
or may have been added when you installed Translate. Follow the instructions in this section only 
if you are having trouble displaying or entering text in a particular language. 
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To set up Windows XP for additional languages 

Support for most languages is pre-installed. Follow the steps below to install additional 
languages, which may include East Asian languages, languages entered right to left 
languages, and languages requiring complex scripts. Have your Windows XP CD handy. 
You may be prompted to insert it so that additional languages can be downloaded to your 
computer. 

1. Open the Windows Control Panel from the Start menu.  

2. Under 'Pick a Category', click the Date, Time, Language, and Regional Options 
icon. 

3. In the area under 'or pick a Control Panel icon' click the Regional and Languages 
Options icon. 

The Regional and Languages Options dialog box appears. 

4. Select the Languages tab and under 'Text services and input languages' click the 
Details button.  

The 'Text services and input languages' dialog box appears. The languages already 
installed are shown in the box. 

5. Click Add to open the 'Add input language' dialog box. 

6. Select the desired language from the pull-down menu and then click OK. 

You can repeat steps 5 and 6 if you want to add additional languages. 

7. Click Apply in the 'Text services and input languages dialog' to save your new 
settings and then click OK. 

8. If you want to install support for Asian languages, right to left languages, or 
languages requiring complex script, go to the 'Regional and Language Options' 
dialog box, select the appropriate check box(es) in the 'Supplemental languages' 
area of the dialog box, and then click Apply. 

You may be prompted to insert your Windows XP CD so the new languages can be 
downloaded.  

9. When installation is complete, click OK to close the Regional and Language 
Options dialog and then close the Control Panel. 

 To set up Windows 2000 for additional languages 

1. Click the Start menu on the Windows task bar, point to Settings, and then click 
Control Panel. 

2. In the Control Panel window, double-click the Regional Options icon. 
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The Regional Options control  panel opens. 

3. Click the General tab in the control  panel. 

4. In the ‘Language settings for the system’ area at the bottom of the control  panel, 
select the checkbox next to each language you want to use. 

5. Follow any instructions that appear, such as inserting the Windows CD or 
restarting your computer. 

6. Click the Input Locales tab. 

7. Click the Add button to display the Add Input Locale dialog box. 

8. Select the desired locale from the ‘Input locale’ menu, and click OK. 

When you change the input locale, the keyboard layout selection also changes.  

9. Repeat steps 7 and 8 to add as many locales as you need, and when done, close the 
control  panel by clicking the ‘X’ in the upper right corner. 

To set up Windows ME, 98, and NT for additional languages 

Older Windows versions, such as ME, 98, and NT, may lack built-in support for displaying 
some languages. 

The steps required to add limited Input support* for East Asian languages on Windows 98, 
Windows ME and Windows NT are different depending on whether or not you have Office 
XP installed. These steps are described in more detail at: 
http://www.microsoft.com/windows/ie/downloads/recommended/ime/default.asp 

  

� If you do NOT have Microsoft Office XP installed on your computer, install 
Global IME 5.02: 

  

1. Go to  
http://www.microsoft.com/msdownload/iebuild/ime5_win32/en/ime5_win32.htm    

2. Choose the support for the desired language WITH the Language Pack if available. 

3. Proceed with the download and follow instructions to install, and reboot. 
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� If you have Microsoft Office XP installed on your computer, install IMEs for 
Office XP: 

  

1. Go to: 
http://office.microsoft.com/assistance/2003/articles/odownloadinputmethodeditors.a
spx 

2. Choose the language you want to add support for. 

3. Proceed with the download and follow the instructions that appear as you install. 
  

*Note: The usefulness of Global IME on Windows 98 and Windows ME is limited to 
certain Microsoft applications such as Internet Explorer, Outlook Express, and the 
Office suite of application. You cannot use Global IME to input East Asian language 
scripts directly into LEC applications. Global IME does permit you to enter the East 
Asian scripts into the Microsoft applications, and you can then use the LEC translation 
tools to translate those scripts. 
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LogoTrans: Translating for 
Quick Understanding 

LogoTrans is designed for fast and easy translation of up to a few pages of text. You can translate 
text in three ways: as you type, when you drag and drop text from another application, or by 
loading a text file. 

As soon as you enter source text in the upper pane of the LogoTrans window, its translation 
appears in the lower pane. No commands are needed. The translation happens automatically and 
instantly. 

LogoTrans works best with amounts of text small enough to fit in the window. It is not intended 
for large documents or as a place to do polished, permanent translations. Rather, use LogoTrans 
for quick tasks such as translating a letter or checking the meaning of sentences as you read. 

You can refine the translation of individual words by choosing from a list of alternate translations. 
You can save the contents of the LogoTrans window as a file and print the contents of either pane. 
You cannot edit the translation directly. 

To open LogoTrans 

� open LogoTrans by choosing Programs/Language Engineering/LogoTrans from 
the Windows Start menu  

When launched, LogoTrans places an icon in the system tray on the Task Bar.. 

� When the window is hidden, click the LogoTrans icon in the system tray to bring 
the window to the front. 

The system tray is usually located at the lower right corner of your screen. You can 
also open LogoTrans from the Windows Start menu by choosing Program 
Files/Language Engineering/LogoTrans.  

You can also set a keyboard shortcut to open LogoTrans. For more information, see 
“To set a hot key”. 

Before entering the text you want to translate, choose the translation languages pair. 
For more information, see the section Choosing Languages. 

To translate as you type 

� Type in the upper (white) pane of the LogoTrans window.  

Translating begins as soon as you stop typing. 

You can add text to the upper pane or modify what you have already typed. LogoTrans 
rapidly detects the changes and re-translates the contents of the window. 
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To translate text from another application 

There are several ways to move text selected from another application into LogoTrans.  

� Select a block of text in any application that supports drag and drop text editing 
and drag it onto the LogoTrans window. 

When the upper pane is hidden, drag the text onto any part of the LogoTrans window 
except the translation pane. Only the translation will appear, not the source text. 

� Copy the text, click inside the upper LogoTrans pane and paste the text. 

� When a hot key is enabled, simply select the text in the other application and press 
the hot key. 

To translate a file 

You can use LogoTrans to translate small text files. LogoTrans is not designed to open files 
created by word processing applications, such as Microsoft Word, unless they are first 
saved in TEXT ONLY format. 

� To open and translate a text file, choose Load Source from the file menu, locate 
and select the file, and click Open. 

LogoTrans begins translating the file as soon as it opens. 

To check a translation 

When you are translating into an unfamiliar language, how can you make sure your 
message will be understandable? One way is to translate the translation back into the 
original language. Every translation may introduce inaccuracies, so if this “back 
translation” is understandable after being translated twice—even if the result is far from 
elegant, you have good reason to think the first translation is reasonably accurate. 

1. Choose Translate Back from the Tools Menu. 

A new window opens and immediately begins translating the text in your translation 
pane.. The language pair in the new pane is set to the opposite dirction from the 
LogoTrans setting. For example, if LogoTrans is set to translate from English to 
Spanish, the new pane automatically translates from Spanish to English. 

To choose an alternate translation 

Alternate translations may not be available for every language. 

1. To see alternate translations for a word, select the word and click on it with the 
right mouse button to show a context menu 

A sub-menu with alternates for the selected word appears. A check mark appears next 
to the current translation. 
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2. Click the alternate translation you prefer. 

Your choice replaces the original word in the bottom pane.  

Notes  

When a selected target word corresponds to an idiomatic source expression containing 
two or more words, LogoTrans highlights the entire expression. When a selected 
translation has no corresponding source word, or vice versa, LogoTrans does not 
provide alternates. For example, Japanese particles such as ga and wa rarely have a 
corresponding English word, and many English particles such as out in a sentence like, 
“I bought him out,” do not have a Japanese equivalent.  

In order to provide as many choices as possible, LogoTrans does not distinguish 
between uppercase and lowercase letters.  

Caution: If you choose alternate words in a sentence and then retranslate the sentence, 
the new translation may replace your choices.  

To set LogoTrans to translate only on request 

LogoTrans is preset to translate as soon as text is detected. You can set the application to 
wait for your command.  

1. Choose LogoTrans Options from the Options menu and click the Source tab.  

2. Uncheck the option labeled ‘Automatically translate source text on the fly’ and 
then click OK. 

LogoTrans adds a Translation menu to the menu bar.  

3. To begin a translation, enter the source text and choose Translate from the menu. 

To set a hot key 

When LogoTrans is running but its window is hidden, the window can be displayed by 
using the hot key sequence. You can also use the hot key to quickly translate any text 
selected in another application. By default the hot key is not in effect when LogoTrans is 
first launched.  

1. Choose LogoTrans Options from the Options menu and click the Hot Key tab. 

2. Check Use Hot Key. 

The default sequence is Ctrl + Alt + Q.  

3. To change the hot key, click inside the box and press the keys you want. 

The sequence must include the Alt key and can include only one alpha-numeric 
character. To avoid confusion, you should not choose the same Hot Key sequence for 
both LogoTrans and other translation applications. 

4. Click OK. 
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Once you have checked Use Hotkey, the commands on the File menu change. Exit is 
replaced by two commands: Hide and Disable LogMedia LogoTrans. Hide closes the  
window but leaves the program running in the background; pressing the hot key opens 
the window again. Disable LogMedia LogoTrans exits the program entirely; to reopen 
it, you must use the desktop icon or Windows Start menu. 

The hot key will work until you exit LogoTrans. LogoTrans remains running in the 
background when you close it or its window is hidden. When you restart your computer 
after shutting down, LogoTrans starts automatically and remains in the background 
until you open its window by using the hot key or clicking its icon in the system tray. 

To save a translation 

LogoTrans lets you save the source text and translation to a text file. 

1. Choose Save As from the File menu. 

2. Select what to save by checking the Source box, the Translation box, or both boxes 
in the lower left corner of the dialog box. 

3. In the dialog box, enter a name for the file, select a folder location, and click Save. 

To print the source text or translation 

LogoTrans lets you print the contents of either the upper or lower pane. 

1. Choose which to print by choosing Print from the File menu. 

2. In the Print dialog box, select the desired printing options, and click OK. 

To resize the source and translation panes 

� Drag the separator between the panes up or down. 
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TransIt: Translating for 
Quick Input to Other 

Applications 
TransIt is designed to provide short translations as quickly and simply as possible and place them 
in another application. It remains hidden when not in use, takes up very little space on your screen, 
and lets you move back and forth easily between translating and working in your primary text 
application. A mouse is not required to enter text, translate, or edit, so TransIt is especially 
convenient for those who prefer to work from the keyboard. 

TransIt works with applications that accept text entry. For example, you can use it to specify 
search text in an Internet browser, or to help you reply to chat or an instant message from another 
country. 

The TransView window lets you monitor a window in another application and translate any text 
that appears there in the opposite direction from the direction TransIt is set to translate. For 
example, if you are using TransIt to translate from English to Spanish, the TransView window will 
show translations from Spanish to English. That makes TransIt and TransView an ideal 
combination for translating messages before sending them with your chat or instant message 
software, and then seeing any reply you receive immediately translated back into your own 
language. 

TransIt lets you replace the translation of individual words by choosing from a list of alternates, 
and you can edit translations directly. 

To open TransIt 

1. To open TransIt, double-click its icon on the Windows desktop.  

You can also open TransIt from the Windows Start menu by choosing 
Programs/Language Engineering/TransIt. 

When launched, TransIt places an icon in the system tray on the Task Bar. If its 
window is hidden, you can restore it by clicking the icon. 

You can also set a keyboard shortcut to open TransIt. For more information, see To set 
a hot key. 
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To enter and translate text 

1. Click the translation languages button and select the languages and direction for 
translation. 

2. Type or paste source text into the white area of the TransIt window. 

You can press Ctrl+V to paste or click the menu icon  and point to Edit; then choose 
Paste from the sub-menu that opens. 

The text is shown in blue and the text area expands to accomodate the text you enter.  

3. Press Enter on your keyboard. 

TransIt translates the text and displays the translation in black. 

You can also translate by clicking the menu icon and choosing Translate from the 
menu that pops up. 

To choose an alternate translation 

1. Select a word in the translation. 

You can use the left and right arrow keys to move from one word to another. 

2. Press the up arrow to open a list of alternate translations. 

3. If you see a translation you prefer, use the up and down arrow keys to select it; 
then press Enter. 

Your choice replaces the original word in the bottom pane.  

You can also edit the translation directly, but once you do, alternate words may not be 
available. For that reason, make final edits after choosing alternate words. 

To insert the translation into another application 

When you are satisfied with the translation, you can quickly insert it into another running 
application. Make sure the text cursor in that application is positioned where you want the 
translation inserted. 

� Press Enter on your keyboard. 

Or click the menu icon and choose Commit from the menu. 

TransIt is hidden, the other application window becomes active, and the translation is 
inserted at the text cursor. 
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To clear the window 

� To clear the window at any time, press Esc. 

After translating, you can also clear the window by clicking the menu icon and 
choosing New Translation from the menu. 

To translate in the opposite direction 

The TransView window translates text in the opposite direction from the translation 
languages set in TransIt. For example, when TransIt is set to translate from English to 
Spanish, TransView translates from Spanish to English.  

You can set the TransView window to monitor another text window and translate any text 
that appears there. The translation occurs automatically. TransView can monitor 
applications that accept text entry, such as Notepad, WordPad, and most chat and instant 
message software.  

1. If the TransView window is not visible, click the TransIt menu icon  and choose 
Show TransView from the menu. 

2. Open the application you want to monitor. 

3. Drag the selector icon  from the TransIt window and drop it in the window you 
want to monitor. 

The outline of the window is highlighted briefly. Any text in TransIt’s translation 
language that appears in the selected window is displayed in the TransView window 
translated into TransIt’s source language. Whenever new text appears in the window, it 
is translated automatically.  

Tip: When you want to translate from a window that TransView cannot monitor, you 
can copy the text and paste it into the TransView window. To paste text that you have 
copied, click inside the TransView window and press Ctrl+V on your keyboard. The 
pasted text appears briefly in italics and then is replaced by the translation. 

To translate to and from Instant Messenger or Chat 

Used together, TransIt and the TransView window let you exchange messages with 
someone who is writing in an unfamiliar language. 

Follow the steps below to write and translate a message you want to send. 

1. Open your instant message or chat application. 

2. Click your mouse once in the Send window. 

3. Open TransIt and select the translation languages for translating from your 
language to your recipient’s. 
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4. Type your message in TransIt.  

5. Press Enter on your keyboard. 

TransIt displays the translation. You can choose alternate translations for words and 
edit the translation if you like. 

6. Press Enter again. 

The translated text is inserted into your instant messaging or chat Send window. 

Note: When using CompuServe Chat, you must select the translated text, copy it, and 
then paste it into the chat window. To do that, click inside the translation and press 
Ctrl+A to select all the text, then press Ctrl+C to copy it. Click inside the chat window 
and press Ctrl+V to paste the text there. 

7. If necessary, repeat steps 2 through 6 until your message is ready to go, then click 
Send in your messaging or chat application. 

Follow the steps below to translate messages you receive: 

1. If the TransView window is not visible, click the TransIt menu icon  and choose 
Show TransView from the menu. 

2. Drag the selector icon  from the TransIt window and drop it in your instant 
message or chat software, inside the window where messages are received. 

When your correspondant replies to your message, his or her reply will be translated 
automatically and be displayed in a more familiar language in the TransView window. 

Note: If received messages do not appear in the TransView window automatically, you 
can copy the text and paste it into the TransView window. To paste text you have 
copied, click inside the TransView window and press Ctrl+V on your keyboard. The 
pasted text appears briefly in italics in the language in which it was written and then is 
replaced by the translation. 

To set a hot key 

When TransIt is running but its window is hidden, you can display it by pressing the hot 
key sequence. Conversely, when the TransIt window is visible, using the hot key will hide 
it.  

1. Click the menu icon and choose Add Hot Key from the menu. 

2. In the dialog box, check Use Hot Key. 

The default sequence is Ctrl+Alt+T.  

3. To change the hot key, click inside the box and press the keys you want; then click 
OK. 
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The sequence must include the Alt key and can include only one alpha-numeric 
character. To avoid confusion, you should not choose the same hot key sequence for 
both TransIt and other translation applications. 

Once you have checked Use Hotkey, the commands on the File menu change. Exit is 
replaced by two commands: Hide and Disable LogMedia TransIt. Hide closes the 
window but leaves the program running in the background; pressing the hot key opens 
the window again. Disable LogMedia TransIt exits the program entirely; to reopen it, 
you must use the desktop icon or Windows Start menu. 

The hot key will work until you exit TransIt. TransIt remains running in the 
background when you close it or its window is hidden. When you restart your computer 
after shutting down, TransIt starts automatically and remains in the background until 
you open its window by using the hot key or clicking its icon in the system tray. 

To set when TransIt is visible 

If you expect to use TransIt several times during your text application session, you may 
want to keep its window open so that it is visible and easily available with a mouse click.  

If you would prefer to have the window out of the way, you can set it to remain invisible 
except when explicitly invoked.  

� To keep the TransIt window open, click the pushpin icon, so it appears to pin the 
TransIt window to your desktop. 

The window will retain its position on the screen, floating above other applications. 
You can change its location by dragging the window.  

To hide the window, click the menu icon and choose Hide from the menu. 

� To have the window appear only when invoked, click the pushpin icon, so it 
appears to lie on its side. 

The TransIt window vanishes whenever you click outside it or make another 
application active. TransIt remains running in the background. 

Until you actually exit TransIt, you can bring the window back at any time by pressing 
the Hot Key or clicking the TransIt icon in the system tray on the Task Bar, provided 
that you have enabled one or both of these options. When the window appears, it 
positions itself slightly below the text cursor in your application. 

To change the TransIt display 

1. Click the menu icon and choose TransIt Options from the menu. 

2. In the Settings dialog box, click the Miscellaneous tab. 
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3. Select from the following options, then click OK. 

TransIt window remains at fixed location. When checked, keeps the window open 
when inactive (the same effect as “pinning” the window with the pushpin icon). 

Show TransIt control on Task Bar. When checked, places an icon on the Windows 
system tray. Clicking the icon opens the TransIt window. 

Show Pushpin. When checked, displays the pushpin icon in the TransIt window. 

Show TransView Window Chooser. When checked, displays the selector icon that 
lets you designate a window in another application, for example, a chat window, to 
monitor in the TransView window. 

Show Translation Languages Chooser. When checked, displays the translation 
languages button in the TransIt window. 

Show Menu. When checked, displays the menu icon in the TransIt window. 

Note: To open the menu when its icon is not displayed, right-click inside the text-entry 
area of the window. 

To resize the TransIt window 

� Point to the window border and when the pointer changes to a two-headed arrow, 
drag the window border. 

To change Translation Options 

See the section Setting Translation Options. 

To use TransIt from your keyboard 

TransIt is designed to work from your keyboard, with minimum need for your mouse. 

z Use Enter to translate text after you have entered it. 

z Press Enter again to send the translation to another application. 

z Use Escape (Esc) to clear the text area so you can start over. 

When the text area is clear, Esc hides the TransIt window. 

z Use Left and Right Arrow to move from one selected word to another in translated 
text. 

z Use Up Arrow key to display a list of alternate translations for a selected word. 

Then use Up Arrow to move up the list of alternate translations, from one word to 
another. 

z Use Down Arrow to move down the list of alternate translations, from one word to 
another. 
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Note: To use the arrow keys for their normal, non-TransIt functions, combine them 
with the Control (Ctrl) key. 

To exit TransIt 

Exiting shuts TransIt off completely. 

� Choose Disable LEC TransIt from the TransIt menu. 

The hot key is disabled and the TransIt icon is removed from the system tray. 

When you next want to use TransIt, open it from the Start menu.  
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Translation Mirror: 
Monitoring & Translating 

Text from another 
Application 

Translation Mirror can monitor the window of another application and translate its contents. It 
responds automatically to changes to the text in the other window. Translation Mirror works with 
many applications that accept text, including chat, instant message software, Notepad, and 
WordPad. 

To use Translation Mirror 

1. Open Translation Mirror by double-clicking its icon on the Windows desktop. 

You can also open it from the Windows Start menu by choosing Program 
Files/LEC/Translation Mirror.  

When launched, Translation Mirror places an icon in the system tray on the Task Bar. 
If its window is ever hidden, you can restore it by clicking the icon. 

You can also set a keyboard shortcut to open Translation Mirror. For more information, 
see To set a hot key. 

2. Click the translation languages button and choose a language pair and direction 
for the translation. 

3. Open the application you want to monitor. 

4. Drag the selection icon  from the lower left corner of the Translation Mirror 
window to the document window or text entry window you want to monitor.  

The outline of the window is momentarily highlighted. 

5. Type in the window being monitored. 

Or, open a document in the window. 

The source text immediately appears in Translation Mirror in italics and is translated 
automatically. The translation then replaces the source text. Whenever new text is 
added or replaces the original contents of the application window, it automatically 
appears in Translation Mirror and is translated. 
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6. If you want to save a translation, choose Save As from the File menu. 

Be sure to save the translation before new text appears in the original application 
window to replace it.  

7. To exit Translation Mirror choose Exit from the File menu. 

Tips: If a compatible application window is already open when you open Translation 
Mirror, it will automatically target that window, and you may not need to select an 
application window to monitor. If more than one window is open, Translation Mirror 
targets the topmost window. You can also set Translation Mirror to target the topmost 
application window by clicking the selection icon once. 

To set a hot key 

When Translation Mirror is running but its window is hidden, you can display it by pressing 
the hot key sequence. Conversely, when the Translation Mirror window is visible, using the 
hot key will hide it.  

1. Choose Add Hot Key from the Options menu. 

2. In the dialog box, check Use Hotkey. 

The default sequence is Ctrl+Alt+V.  

3. To change the hot key, click inside the box and press the keys you want; then click 
OK. 

The sequence must include the Alt key and can include only one alpha-numeric 
character. To avoid confusion, you should not choose the same Hot Key sequence for 
both Translation Mirror and other translation tools. 

Once you have checked Use Hotkey, the commands on the File menu change. Exit is 
replaced by two commands: Hide and Disable LogMedia Translation Mirror. Hide 
closes the window but leaves the program running in the background; pressing the hot 
key opens the window again. Disable LogMedia Translation Mirror exits the program 
entirely; to reopen it, you must use the desktop icon or Windows Start menu. 

The hot key will work until you exit Translation Mirror. Translation Mirror remains 
running in the background when you close it or its window is hidden. When you restart 
your computer after shutting down, Translation Mirror starts automatically and remains 
in the background until you open its window by using the hot key or clicking its icon in 
the system tray. 
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To keep Translation Mirror in front 

You can set the Translation Mirror window to float when you want it to stay in front of all 
other application windows. 

1. Choose Translation Mirror Options from the Options menu. 

2. In the Settings dialog box, click the Miscellaneous tab. 

3. Check the box ‘Translation Mirror window should float above all applications’, 
then click OK. 

Uncheck the box when you want the window to behave like other application windows. 
Then when the window is hidden behind other windows, you can bring it to the front 
by pressing the hot key or clicking its icon in the Windows system tray. 

To resize the Translation Mirror window 

� Point to the window border and when the pointer changes to a two-headed arrow, 
drag the window border. 

To hide the Translation Mirror window 

You can hide the window without exiting Translation Mirror when a hot key is enabled. 

1. Choose Hide from the File menu, or click the window’s close box. 

To open the window again, press the hot key or click the system tray icon. 

Note that when the hot key is disabled, the Hide command is not available, and clicking 
the close box exits Translation Mirror. 

To exit Translation Mirror 

When a hot key is enabled, clicking the close box hides the Translation Mirror window 
without actually exiting the program. You can disable Translation Mirror when you want to 
turn the application completely off. 

� To exit, choose Disable LogoTrans from the File menu. 

The hot key is disabled and the Translation Mirror icon removed from the system tray. 

Use the Start menu or the desktop icon to open Translation Mirror again.  
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FileTrans: Translating Files 
in the Background 

FileTrans is the easiest way to translate one or more text files or HTML files from one language to 
another. FileTrans performs translations quickly and efficiently in the background, freeing your 
computer for other work.  

You can drag a file onto FileTrans and have the translation appear automatically when it finishes. 
Or, you can drag a directory of files onto FileTrans and have all of the files translated 
automatically, with file names and subdirectories intact. You can even drag text directly from your 
text editor and have it translated immediately.  

FileTrans can read plain text, Unicode, and HTML files (and you can change the handling of any 
file type as needed). The translation files are created automatically.  

Note: FileTrans does not accept files created by popular word processors such as Microsoft Word 
or Word Perfect unless you have first saved the files as TEXT ONLY in your word processor. 
FileTrans currently cannot open Japanese EUS or JIS. 

To prepare a file that you want FileTrans to translate 

When you want to use FileTrans to translate a web page or word processing document, such 
as a document created by Internet Explorer, Microsoft Word, or Word Perfect, you must 
first save the file in HTML or TEXT ONLY format. 

1. Open the document in your web browser or word processing application. 

2. Choose Save As from the File menu. 

3. In the ‘File Name’ box, type a new name for the file. 

Providing a new name insures that both your original document and the HTML or 
TEXT ONLY version remain on your hard drive. 

4. In the ‘Save As Type’ box, select one of the following: 

z To save a web page with its original formatting (but without images) select ‘HTML 
only’. 

z To save the words on a web page, without their original formatting select ‘Text file’ 
or TEXT ONLY. 

z To save the words in a word processing document (without any special formatting) 
select ‘Text file’ or TEXT ONLY. 

5. If you like, select a folder location for the saved file. 
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6. Click Save. 

Text files are saved with the extension ‘.txt’; HTML files are saved with the extension 
‘.htm’. 

To open FileTrans 

� Double-click the FileTrans icon on your desktop. 

You can also open FileTrans from the Windows Start menu. Choose 
Programs/Language Engineering/FileTrans. 

To translate files and folders 

There are several ways to translate one or more text files or HTML files with FileTrans:  

� With FileTrans running, drag and drop one or more document icons onto the 
FileTrans window.  

� With FileTrans running, drag and drop the selected text from another open 
application onto the FileTrans window.  

� With FileTrans running, click Translate in the FileTrans window and select a file 
in the directory dialog box; then click Open. 

� In a desktop window or the Windows Explorer, drag one or more document icons 
to the FileTrans icon.  

There are several ways to translate the contents of one or more folders: 

� With FileTrans running, drag and drop one or more directory icons onto the 
FileTrans window.  

� With FileTrans running, click the Translate button, open the folder to be 
translated and then click the Translate Folder button.  

� In a desktop window or the Windows Explorer, drag one or more directory icons 
to the FileTrans icon.  

The FileTrans window shows the number of files to be translated, the name of the file 
currently being translated, and a progress bar.  

Where are translated files saved? 

When FileTrans has finished translating a single document, it saves the translation in 
the same folder as the original file. The translation file has the same name as the 
original, with a prefix indicating the new language. For example, a Japanese translation 
of ‘mysample.txt’ is saved as ‘[J] translation of mysample.txt’.  



Translate 2004 User Guide 46 

When translating an entire folder, FileTrans creates a new folder with the files and sub-
folders all in the same place as in the original folder. This new folder is labeled with a 
prefix to indicate that it contains translations, but each of the files has exactly the same 
name as the source file. For example, translation of a folder called ‘MyFiles’ to 
Spanish would result in a new folder named ‘[S] translation of MyFiles’ and containing 
files and sub-folders with the same names as those inside ‘MyFiles.’ Of course, the 
files in this new folder have been translated into the target language.  

When you have dropped selected text on the FileTrans window, FileTrans always 
opens a window in your default text editor, for example Notepad, and displays the 
translated text there. When you want to keep the translation, save it as a file. 

To stop translation before it is completed 

� Click Stop.  

All completely translated sentences are saved. 

To select how completed translations are displayed 

1. In the FileTrans window click Options to open the Settings dialog, and then click 
the Miscellaneous tab. 

2. To view the translation immediately, select Open translated file when finished, 
then click OK. 

The translated files will open in an application window.  

To delete source files after translation 

1. In the FileTrans window click Options to open the Settings dialog, and then click 
the Miscellaneous tab. 

2. To delete the source file after translation, select Discard original file when finished, 
then click OK. 

To select which files are interpreted as HTML 

We recommend against changing the original settings unless you are an advanced user and 
know exactly what you want to do. 

1. In the FileTrans window click Options to open the Settings dialog, and then click 
the HTML Files tab. 

An alphabetical list shows file extensions that FileTrans interprets as marked up and 
whether FileTrans interprets the markup as HTML. 

2. Revise the list: 
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z To remove a file type from the list select it and click Delete. 

z To add a file type click Add, type the file extension in the box (replace the question 
marks and do not type an initial dot), then click anywhere in the list to save the new 
item. 

z To change how FileTrans interprets a file type select it in the list and under ‘Treat 
extension as’ click HTML. 

z To restore the original list click Factory Defaults 

Note: When you add an extension it appears in the list alphabetically. Adding an 
extension and setting how FileTrans interprets it require separate steps: you must add 
the extension, then select the new extension in the list and click HTML. 

3. Click OK. 
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To specify which file types are ignored 

The Files to Ignore tab in FileTrans’ Settings dialog lists file types that you do not want 
FileTrans to translate. We recommend against changing the original settings unless you are 
an advanced user and know exactly what you want to do. 

1. In the FileTrans window click Options to open the Settings dialog, and then click 
the Files to Ignore tab. 

An alphabetical list shows file extensions that FileTrans will not translate and whether 
FileTrans will copy such a file untranslated into the translation folder or ignore the file 
entirely. 

2. Revise the list: 

z To remove a file type from the list select it and click Delete. 

z To add a file type click Add, type the file extension in the Extension box (replace 
the question marks and do not type an initial dot), then click anywhere in the list to 
save the new item. 

z To change how FileTrans handles a file type select it in the list and under ‘Copy 
into new folder?’ click Yes or No. 

z To restore the original list click Factory Defaults. 

Note: When you add an extension it appears in the list alphabetically. Adding an 
extension and setting how FileTrans handles it require separate steps: you must add the 
extension, then select the new extension in the list and click Yes or No. 
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Translating To and From 
Other Applications 

Translating text that was created in another application, such as a web browser, word processing 
application, or email software, usually requires you to move the text from the original application 
to the translation tool. After the text is translated, you may want to move the translation back to the 
original application for saving or editing. 

LogoTrans, TransIt, and Translation Mirror are easy to use with other text applications. 

z LogoTrans can be set to read and translate any text that you cut or copy in another application. 

z TransIt can insert translations into many other applications with a single stroke of the Enter 
key. 

z Translation Mirror automatically reads and translates any text that appears in the front-most 
application window on your desktop -- or in whichever other window you select. 

You can find more information about these features in the online help for each of the translation 
tools or in the section of this user guide devoted to each tool. 

Most Translate packages also include ‘add-in’ software that works with Microsoft Word, Excel, 
and PowerPoint to let you translate text right in the document windows of those applications.  

To move text between applications 

For those situations or applications in which the automated text-handling features of 
Translate applications do not work, you’ll want to be familiar with standard techniques for 
moving text. 

1. Select the text you want to move.  

Here’s how: Move the mouse pointer to the beginning of the text. Press and hold the 
left mouse button down while you drag the pointer to the end of the text; then release 
the mouse button. The selected text is highlighted. 

When you want to select all the text in a window, you can also click anywhere inside 
the window and choose Select All from the application’s Edit menu. 

2. Try dragging and dropping 

Most modern applications let you move text by dragging it and dropping it in the 
desired location. Here’s how: Point to the highlighted text, press and hold the left 
mouse button down while you drag the pointer to the desired location; then release the 
mouse button. 
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3. If drag and drop doesn’t work, copy and paste the selected text.  

Here’s how: After selecting the text, choose Copy from the Edit menu of your 
translation tool, click in the location where you want to place the text, and then choose 
Paste from the Edit menu of that application. 

To choose these commands in TransIt, click the menu button in the TransIt window 
and on the menu that opens click Edit, then choose from the sub-menu. 

To translate the content of a Microsoft Word, Excel, or 
PowerPoint document 

The LEC Word, Excel, and PowerPoint Add-Ins add a Translate menu to those applications. 
The commands on the menu let you translate directly from your Word, Excel, or 
PowerPoint document.  

� To select the translation language, choose Language Pair from the Translate 
menu and then select the language you want from the sub-menu that opens. 

� To translate the entire document, choose Translate All from the Translate menu. 

� To translate part of the document, select the text you want to translate and then 
choose Translate Selection from the Translate menu. 

Each translation appears in a new document window. Character and paragraph style 
information is not included in the translation, so the translation text will not have the 
same appearance as the original. The source text remains unmodified in the original 
document window. 

Tip: To check whether a translation is understandable, change the language pair to the 
opposite direction and translate the translation back into the original language. 

To translate to and from Instant Messenger or Chat 

Used together, TransIt and the TransView window let you exchange messages with 
someone who is writing in an unfamiliar language. 

Follow the steps below to write and translate a message you want to send. 

1. Open your instant message or chat application. 

2. Click your mouse once in the Send window. 

3. Open TransIt and select the translation languages for translating from your 
language to your recipient’s. 

4. Type your message in TransIt.  

5. Press Enter on your keyboard. 
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TransIt displays the translation. You can choose alternate translations for words and 
edit the translation if you like. 

6. Press Enter again. 

The translated text is inserted into your instant messaging or chat Send window. 

Note: When using CompuServe Chat, you must select the translated text, copy it, and 
then paste it into the chat window. To do that, click inside the translation and press 
Ctrl+A to select all the text, then press Ctrl+C to copy it. Click inside the chat window 
and press Ctrl+V to paste the text there. 

7. If necessary, repeat steps 2 through 6 until your message is ready to go, then click 
Send in your messaging or chat application. 

Follow the steps below to translate messages you receive: 

1. If the TransView window is not visible, click the TransIt menu icon  and choose 
Show TransView from the menu. 

2. Drag the selector icon  from the TransIt window and drop it in your instant 
messaging or chat software, inside the window where messages are received. 

When your correspondant replies to your message, his or her reply will be translated 
automatically and be displayed in a more familiar language in the TransView window. 

Note: If received messages do not appear in the TransView window automatically, you 
can copy the text and paste it into the TransView window. To paste text you have 
copied, click inside the TransView window and press Ctrl+V on your keyboard. The 
pasted text appears briefly in italics in the language in which it was written and then is 
replaced by the translation. 

To translate email 

When sending and receiving email, you may want to translate your messages into a 
recipient’s language and translate messages you receive into a language that is more 
familiar to you. 

To translate a message before you send it: 

1. Open LogoTrans and select the translation language that will translate your 
message into a language your recipient is more familiar with. 

2. Type your message in the upper pane of LogoTrans. 

If you are creating a long message, you may want to translate a few sentences at a time 
and transfer them to your email application. When you pause in typing, the sentences 
are translated and the translation appears in the lower pane. 

3. Click inside the lower pane and choose Select All from the Edit menu. 

The translation is selected. 
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4. Open your email application and open a new message form. 

5. Move the translation from LogoTrans to your email message window 

If your email application accepts drag and drop text editing, try dragging the selected 
text to the message window. If not, use the Copy command on the LogoTrans Edit 
menu to copy the selected translation, click inside your email message window, and 
choose Paste from the email program’s Edit menu. 

6. Enter the recipient’s address and the message subject and send the message. 

To translate a message you receive: 

1. Click inside the the message you want to translate. 

1. Open Translation Mirror. 

Translation Mirror should target the window you clicked and the text of the message 
should appear in the Translation Mirror window. If not, drag the Translation Mirror 
selector icon  to the message window. If the text of the message still does not 
appear, Translation Mirror may not work automatically with your email application; 
you must then copy and paste (or drag and drop) the text of the message into the 
Translation Mirror window. 

2. Click the translation languages icon and select a language that will translate the 
message into a language more familiar to you. 

In the Translation Mirror window, the original text is replaced by the translation. 

Tip: You may prefer to use TransIt to write and translate brief emails and TransView to 
translate emails you receive. When writing a message in TransIt, press Enter after each 
sentence to translate it, and then press Enter again to pop the translation into your email 
message window. 
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Working with Dictionaries 
The Translate applications translate only the words they find in their electronic dictionaries, so the 
completeness and accuracy of the translations depend upon the completeness and accuracy of your 
dictionaries. 

A LEC dictionary (also called a system dictionary or main dictionary) is installed for each set of 
translation languages and opens whenever your translation application uses those languages. The 
LEC dictionary contains translations for many idiomatic expressions as well as individual words. 
You can browse a LEC dictionary and look up words, but you cannot modify it. 

Most Translate products let you supplement the system dictionary with subject dictionaries, which 
contain terms used in specialized fields such as computers, business, or medicine. Most Translate 
products also let you employ user dictionaries, which you create and modify yourself. A user 
dictionary lets you:  

z Define words not included in any other dictionary, for example, product names, nicknames, and 
specialized terms.  

z Supersede a translation in the system dictionary.  

z Define a compound word or phrase (such as hot dog) which has a translation different from the 
translations of the individual words.  

z Translate words appropriately for a particular document or project. For example, when 
translating an article about rivers, you may want current to mean ‘flow of water’ instead of 
‘flow of electricity’ or ‘in use at this time’.  

z Prioritize or weight a preferred translation so that it is favored over other translations of the 
same word.  

In order to correctly interpret and translate nuances of meaning, system dictionaries classify words 
according to complex rules. System dictionaries also utilize many more parts of speech than the 
standard rules of grammar provide. Entries in user dictionaries do not have the same level of 
complexity. As a result, you may find that your user dictionaries at times do not improve a 
translation, and may, in fact, yield less desirable results than you can achieve with the system 
dictionaries alone.  

Note: Subject dictionaries, user dictionaries, dictionary browsing, and dictionary editing are not 
available for every translation language or version of Translate. See the system specifications for 
each product. 
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Setting Which Dictionaries Are Used When Translating 

The system dictionary for a translation language is used whenever that language is selected. In 
order to supplement the system dictionary with a user dictionary or technical dictionary, you must 
first open that dictionary in the translation options. 

To view a list of dictionaries 

Do the following to view a list of the dictionaries open for translating the current document. 

1. Open the translation application you want to use. 

2. Click the translation languages icon and choose Translation Options from the 
menu that opens. 

3. In the settings dialog box, click the Dictionaries tab. 

Dictionaries in use are shown on the left, available dictionaries not currently being used 
are on the right. Use the arrow keys to start or stop using dictionaries. The main 
dictionary must always be used. There is sometimes a limit on the number of 
dictionaries that can be used. If you have reached the limit the left arrow button will 
gray out. 

Opening and Displaying Dictionary Browser 

Please note that the Dictionary Browser application, used to browse and edit dictionaries, is not 
included in all versions of Translate. 

To open the Dictionary Browser application 

Whenever you view or edit the contents of a dictionary, you use the Dictionary Browser 
application.  

� Do one of the following to open Dictionary Browser: 

z From the Windows Start menu choose Programs/Language Engineering/Dictionary 
Browser. 

About the Dictionary Browser window 

When you open Dictionary Browser from the Start menu, Windows Explorer, or My 
Computer window, the application has a menu with commands for opening dictionaries, 
navigating a list of found entries, editing user dictionaries, customizing the display and 
setting other options  
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z The selection pane is the row of boxes at the top of the window, just below the 
toolbar. The boses let you select search criteria for finding words in a dictionary. In 
the empty middle box, you can type the word you want to look up. 

z The navigation pane, on the left side of the window, displays the results of a search. 
Words are listed in alphabetical order. The commands on the Navigation menu let 
you switch selections and change how items in the Navigation pane are displayed 

z The details pane, directly below the selection pane and divided into columns labeled 
‘Source’, ‘POS’ (Part Of Speech), ‘Translation’, ‘Dictionary’, and ‘Weight’, 
displays all the dictionary entries for a word you have selected in the navigation 
pane. You can remove columns or add additional columns to the display and can 
sort the list on any column by clicking the column header. 

z The entry properties pane, directly below the details pane, displays complete 
information about an entry you have selected in the details pane. When browsing a 
user dictionary, you can modify the information in the entry properties pane to edit 
the dictionary entry. 

z The dictionaries pane at the bottom of the window, shows the dictionaries that are 
open for browsing. Checkmarks in the left column show which of the open 
dictionaries will be searched when you look up words. You can select or deselect a 
dictionary by clicking in the left column. 

To select which panes are displayed 

You can display or hide several of the panes by choosing them from the Window menu. 
When a pane is displayed, a check mark appears in the menu next to its name. Choosing it 
removes the check mark and hides the pane. 

To show or hide: 

z Status bar at the bottom of the window, choose Status Bar. 

z List of open dictionaries at the bottom of the window, choose Dictionaries Pane. 

To sort the contents of the details or dictionaries pane 

� Click the header of the column by which you want the list sorted. 

To change column widths 

You can change the width of the entry list (navigation pane), as well as the columns in the 
details and dictionaries panes. 

1. In the row of column headers, point to the separator at the right edge of the 
column you want to change. 

To change the navigation pane, point to its right edge. 

The shape of the pointer changes. 
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3. Click and drag the separator to the right to increase the column width, to the left 
to decrease the width. 

To view hidden information in a column 

Sometimes a column is too narrow to view the entire text (for example, a long path name). 

� Point to the text with your mouse. 

After a few moments the entire text will appear in a tool tip rectangle. 

Browsing Dictionaries 

Please note that not all translation languages support dictionary browsing. 

To open a dictionary for browsing 

1. Open Dictionary Browser from the Windows Start menu. 

2. Select the language pair you wish to use with the language pair chooser 

3. use the dictionary panel of Translation Options to set the dictionaries you wish to 
browse or edit 

To find a word or phrase 

You specify what to search for using the boxes in the selection pane at the top of the 
browser window. 

1. In Dictionary Browser, open the dictionaries you want to search. 

2. In the first (Source Text) box, select the part(s) of the dictionary entries you wish 
to search: the source text, the translation text, or both. 

Searching for translation text may not be available in dictionaries for all translation 
languages. 

3. In the next (Starts With) box, specify how you want the search string matched: an 
entry that Starts With or Ends With the search string, forms an Exact Match or 
Rough Match, or All Entries that match. 

All types of search may not be available for particular translation languages. 

Tip: Use Starts With when you want to find all inflected or alternate forms starting 
with the search string. Use Rough Match when you want to find words that may be 
spelled in more than one way. 

4. In the next to last (Any POS) box, select the part of speech to search for. 
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Dictionaries for some translation languages include more parts of speech than others. 

5. In the right-most (All Dictionaries) box, choose the dictionary or dictionaries to 
search.  

To search a combination of dictionaries, select Custom Search; in the dialog box, select 
the check box next to each dictionary you want to search. 

At the bottom of the screen a check mark appears next to each dictionary to be 
searched. Tip: you can select or unselect a dictionary by clicking in this column.  

6. Type the word or phrase you want to find in the text box in the middle of the 
selection pane.  

Tip: A pull-down menu in the box lists recent searches, so that you can repeat a search 
without typing the entry again.  

A list of matching words appears in the navigation pane at the left. The first item found 
(not necessarily the first item in alphabetical order) is selected, and one or more 
dictionary entries for that item appear in the details pane just below the text box where 
you entered the word or phrase.  

The number of matching entries is shown on the Status Bar, at the bottom of the 
window.  

7. To display an particular entry if more than one is found, locate and select the 
word in the list on the left; then, if more than one entry for that word is listed in 
the details pane to the right, select the one you are interested in. 

The parts of the entry appear in the entry properties pane. 

Tip: Try this quick search method: Select Starts With in the second selection box, click 
inside the text box, and type the first few letters. A list of entries appears in the 
navigation pane. The list updates as you type more letters. 

Tip (ES, EJ): To find adjectives with prepositions, or verbs with particles and/or 
prepositions, choose Rough Match and the relevant part of speech and type in the 
adjective or verb without the particle or preposition. For example, search for ‘sure’ 
with ‘Rough Match’ and ‘Adjective’ to display ‘sure’ and ‘sure of’; search for ‘pick’ 
with ‘Rough Match’ and ‘Verb’ to display ‘pick on’, ‘pick out’, and ‘pick up on’, 
among others. 

To find all entries in a dictionary 

1. In Dictionary Browser, open the dictionaries you want to search. 

2. In the Dictionaries box, at the right below the tool bar, select the dictionary whose 
contents you want to view. 

3. In the Starts With box, select All Entries. 

All entries in the dictionary appear alphabetically in the navigation pane. The first is 
selected. 
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Note: You cannot display all entries for any main dictionary or technical dictionary. 
Also, many some language pairs do not support All Entries user dictionaries either. 

To browse a found set of entries 

When a search finds a large number of words, use the following methods to navigate the 
word list and locate the entry you want. For menu commands to be available, you must 
have opened Dictionary Browser from the Windows Start menu, My Computer window or 
Windows Explorer window. 

� Use the commands on the Navigation menu: 

z To collapse the list so that only the source words appear, choose Collapse All. 

z To collapse the selected word, choose Collapse. 

z To view the translation for a collapsed word, select it and choose Expand. 

z To expand every word in the list, choose Expand All. 

z To browse sequentially, choose Next Entry or Previous Entry. 

z To select the first or last word in the list, choose First Word or Last Word. 

� To scan the list, use the scroll bar. 

To select entries 

� To select contiguous entries, hold down the Shift key and clidk each entry. 

� To select non-contiguous entries, hold down the Control key and click each entry. 
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Editing User Dictionaries 

Please note that not all translation languages support user dictionaries. 

To open an existing user dictionary 

You can open any dictionary from within Dictionary Browser. When a dictionary is open 
for translating, you can also open it from within the translation application. You select user 
dictionaries from the Dictionaries panel of Translation Options.  

To create a user dictionary 

You can create as many user dictionaries as you wish for different translation needs.  

1. Open Dictionary Browser from the Windows Start menu. 

2. In Dictionary Browser choose Translation Options from the Tools Menu  

3. Click on the Dictionary tab 

4. Press the “New” button and type in the name you want for the new dictionary  

5. Select the new dictionary, and press the left arrow button to add it to the list of 
dictionaries in use 

To add or edit an entry (English<>Chinese) 

Chinese to English and English to Chinese user dictionaries let you enter source words or 
phrases and their translations as well as specify the entry’s part of speech.  

 

1. If necessary, open the user dictionary 

2. Do one of the following: 

z To create a new entry, choose New Entry from the Edit menu  then enter the word 
or phrase in the Source box. 

z To edit an existing entry, select it in the details pane. 

3. Choose the Part of Speech from the list box: Noun, Verb, Adjective, Adverb, 
Preposition 

4. Type the translation in the Translation box. 

When you click inside the box, the editor switches to Chinese input mode. 

5. To save the entry, choose Save Entry from the Edit menu. 
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To add or edit an entry  
(EF, FE, EG, GE, EI, IE, EP, PE, SE) 

1. If necessary, open the user dictionary 

2. Do one of the following: 

z To create a new entry, choose New Entry from the Edit menu  then enter the word 
or phrase in the Source box. 

z To edit an existing entry, select it in the details pane. 

3. Choose the Part of Speech from the list box: Noun, Verb, Adjective, Adverb or 
Article. 

4. Choose a gender (if necessary) 

When the source language is not English, you must set the gender of the word 
(Masculine, Feminine, Neuter, or Both) 

5. Choose an Inflection Pattern from the list box. 

Choose the word in the listbox that inflects in the same way as your new entry or that 
best describes your entry. The results of your choice are shown just below in the 
Inflections panel so that you can verify and if necessary correct them. 

Notes 

English Nouns. If the plural is formed by adding es, choose ‘Box’, since the plural of 
box is boxes. If the plural is formed by adding just s, choose ‘Boy’. Or, if the noun does 
not have both a singular and a plural, or if the same form is used for both, choose 
‘(Singular Only)’, ‘(Plural Only)’, or ‘(Singular and Plural)’. If you are entering a noun 
which ends with s, you will be offered other choices, such as ‘James’ when you want 
its possessive form to consist of an apostrophe only, or ‘Mike’ when you want it to 
come out as an apostrophe plus s. 

French Nouns. If the plural is formed by adding s, choose ‘Crayon(m)’, since the 
plural of crayon is crayons. If es is added to form the plural, choose ‘Sketch’. If the 
plural is formed by adding x, choose ‘Feu’. If the same form is used for both singular 
and plural, choose ‘Nez’. The choices you are offered will depend on the final letters of 
the noun you are adding; some others are ‘Journal’, ‘Ciel’, ‘Aieul’, and ‘Afflux’. Or 
you may select ‘(Singular)’ or ‘(Plural Only)’, or ‘(Singular and Plural)’. 

English Verbs. If it inflects like ‘kick’ in that it adds s, ing, ed, and ed to make the 3rd 
person singular., the present participle, the past tense, and the past participle 
respectively, then choose ‘kick’. If it inflects like ‘pat’ in that it adds s for the 3rd 
person singular. but doubles the final consonant before adding ing, ed, and ed for the 
other inflections, choose ‘pat’. There are other, less common choices, such as ‘beat’ 
which inflects as beats, beating, beat, beaten.  

Spanish Verbs. You are offered three choices depending on the conjugation of the 
verb (-ar, -er, or -ir) and the possible types of irregularity. For the verb sustituir, for 
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example, the choices are ‘incluir’, ‘vivir’, ‘sentir’, and ‘bullir’, and you would choose 
‘incluir’.  

5. Select a headword, if entering a phrase 

A phrase is a source that contains more than one word. When you enter a phrase, you 
must select a “headword” that will be the word that will be inflected when the phrase is 
inflected. For example, if you enter the phrase “kiss the frog”, and choose “frog” as the 
headword, than the inflections will be “kiss the frog, kisses the frog, kiss's the frog, 
kisses' the frog”. Note: only nouns can be chosen as headwords, and the headword must 
already exist within either the main or the user dictionary. 

6. Type the translation in the Translation text box.  

7. To save the entry, choose Save Entry from the tool bar or the Edit menu. 

To add or edit an entry (EJ, ES)  

1. If necessary, open the user dictionary 

2. Do one of the following: 

z To create a new entry, choose New Entry from the Edit menu  then enter the word 
or phrase in the Source box. 

z To edit an existing entry, select it in the details pane. 

3. Choose the appropriate Part of Speech from the drop-down list, and if additional 
an additional list box appears next to it, use it to describe the word more precisely. 

4. To generate the plural for a noun or inflections for a verb, click the Inflect button. 
Then edit the inflections to correct their spelling if necessary. 

You must type in irregular inflections yourself.  

If a plural noun has no singular, leave the Singular box blank. For example, scissors is 
a plural English noun that has no singular form. Enter it in the Plural box and leave the 
Singular box empty.  

5. Type your translation in the appropriate (Japanese or Spanish) text box and 
provide additional transformation information as required.  

Notes for Japanese translations 

When you click inside the Japanese text box, the editor switches to Japanese input 
mode automatically.  

Choose a Japanese Past Tense for an ambiguous Japanese verb or a Base Verb Form 
for the Japanese translation of an adjective, if asked. 

When you enter a Japanese verb for which the program cannot determine the inflection 
type, you must choose the past tense form of the verb from the Past Tense list. The 
editor identifies the inflection type from the past tense form. For example, if the verb 
you enter is SURU, you may choose between SHITA and SUTTA.  
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If the program does not recognize the verb ending you enter, the Past Tense list 
displays the message ‘Bad Ending’. Correct the verb ending in the Japanese text box.  

When you enter a Japanese adjective with TEIRU/DEIRU, for which the program 
cannot determine the base verb form, you must choose the correct form from the Base 
Verb list. For example, when the adjective you enter is RIKAISITEIRU, you may 
choose between RIKAISURU and RIKAISU.  

When the Japanese translation has the infinitive verb form, you may have to choose the 
past tense form of the verb. For example, when the adjective you enter is 
RIKAIDEKIRU, choose between RIKAIDEKITA and RIKAIDEKITTA.  

When you are entering a transitive verb, provide the Japanese particle which will 
follow the object of the verb.  

You can choose from the drop-down Postposition list or type directly in the box.  

Notes for Spanish translations 

Choose the Gender for a noun. 

When you are entering a verb that takes a preposition, enter the infinitive form of the 
verb in the Translation box and in the list box(es) select the preposition. 

When you are entering a simple adjective (N1 (that is) beautiful), select the preferred 
form of to be and whether the adjective appears before or after the noun in the 
translation. When you are entering an adjective with a preposition (N1 that is fond of 
N2), enter the preferred form of to be and select the preposition in the list box. 

For more information, see Advanced Editing of ES and EJ User Dictionaries. 

6. If one or more Features buttons appears, click each and in its dialog box, check 
the boxes that apply to the noun or noun phrase used with the entry, and click OK. 

Refer to the sentence template that is shown above the Features button(s). It shows 
which part of the sentence, for example the subject or object of a verb or the object of a 
preposition, each set of features describes. 

You can select one or more features. To have the system generate features for you, 
leave all the boxes unchecked. 

For more information, see the chapter Advanced Editing of ES and EJ User 
Dictionaries. 

7. Set the Priority for the entry.  

Check the Preferred [Part of Speech] box to use this translation in preference to other 
translations (when the word appears as the specified part of speech). Leave the box 
unchecked if you do not want to make this entry preferred.  

8. To save the entry, choose Save Entry from the tool bar or the Edit menu.  
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To delete an entry 

1. Select the entry in the details pane or navigation pane.  

2. Choose Delete from the Edit menu.  

3. Confirm the deletion. 

To discard unsaved changes 

� To restore the current entry to its previously saved form, choose Revert Entry 
from the Edit menu. 

You can also click the Revert dictionary entry button on the tool bar. 

To export entries 

To perform large-scale editing tasks or make the content of a user dictionary available to be 
imported to another user dictionary, you can save its contents as an XML file or as a tab-
separated text file. 

XML (EXtensible Markup Language) is a relatively new but increasingly used language 
designed to store, carry and exchange data. It is software and hardware independent, and 
can be used by many different applications.  Editors for XML are widely available. Entries 
transferred between user dictionaries and XML files lose no information in the transition. 
Everything from part of speech to inflections to gender to semantics is retained. 

Tab-separated text files are more limited. Text files can be edited with standard word-
processing or spreadsheet applications. When you import entries from a text file, you will 
have the opportunity to edit each entry and supply information that may have been lost 
during export.  

Note: only user dictionary entries can be exported 

 

1. Open the user dictionary in Dictionary Browser.  

2. Find and select the entries you want to export. 

2. Choose Export Entries from the File menu. 

In the directory dialog box, select ‘Export File” or ‘Tab Delimited’; click Save.  

XML files have the extension ‘.xml’. Text files have the extension ‘.txt’. 

When you save a text file, a dialog comes up letting you specify the field order for your 
export. 
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To edit an XML file, use an XML editor. To edit a tab-separated text file, use a 
spreadsheet, database, or word-processing application 

Note: XML editors automatically check for unbalanced brackets and unclosed tags, 
saving you time.  

To import entries  

Dictionary Browser lets you add the content of an XML or text file to an existing user 
dictionary.  

When you are importing entries, always create a backup of the dictionary first. 

1. Open an existing user dictionary in Dictionary Browser or create a new dictionary.  

2. Choose Import Entries from the File menu and choose the dictionary you want to 
import to from the submenu.  

3. In the directory dialog box, locate the file you wish to import, select it, and click 
Open.  

When importing a text a dialog box will come up, letting you specify how the fields in 
the text file should be used as parts of a dictionary entry. 

Dictionary Browser begins importing the file. An errors window may appear when 
there are problems importing certain entries. 

4. If an errors window appears, resolve the problematic entries: 

z To correct each entry as you import it, select the problematic entry in the errors 
window and click Edit. The Dictionary Browser entry properties pane appears. 
Correct and save the entry.  

z To correct problems in the original file, open the file in an appropriate editor (XML 
editor, text editor or word processor) and make the required corrections. Then save 
the file and begin importing again. Be sure to add the corrected file to a fresh copy 
of your dictionary.  
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Advanced Editing of ES and 
EJ User Dictionaries 

English to Spanish and English to Japanese user dictionaries let you define words very precisely. 
In ES dictionaries, and in EJ dictionaries when the Dictionary Browser editor pane is set to the 
default Advanced Controls, you can select among nine verb types and two adjective types. When 
describing nouns, verbs, adjectives, or prepositions, you can also select semantic features that 
clarify the context in which the word appears. In EJ dictionaries, you can provide additional 
information about the translation. 

This chapter describes the advanced features of the dictionaries and provides examples of how to 
use them in the Dictionaries application. 

Entering English Verbs (EJ, ES) 

About entering the infinitive 

Enter the infinitive form without to. If the meaning of the word depends on its pairing with 
a particle or preposition, include that word in the base form. Examples: send out or tired of. 
However, when entering a reporting verb, such as think that, do not include that. 

About selecting the verb type 

When you select Verb as the part of speech, a drop-down list containing nine items appears 
next to the Part of Speech list. Each item is an example of a different type of verb. Select 
the item that best matches the verb you want to add. The choices are as follows:  

z N1 sleep describes a verb that doesn't take an object, particle, or preposition plus 
noun phrase. 

Examples: He arrived. She laughed. They are rebelling. We will go. 

z N1 depend on N2 describes a verb followed by a prepositional phrase, which 
consists of a preposition plus a noun phrase. 

Examples: She called on the student. We depended on it. They are relying on you. 
She leaned against the door. 

z N1 go out describes a verb followed by a particle. 

Examples: We went out. They walked by. She came in. He fell down. 

z N1 put up with N2 describes a verb followed by a particle and a prepositional 
phrase (prep + noun phrase). 
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Examples: We put up with it (up is a particle, with it is a prepositional phrase). She 
is going along with him (along is a particle, with him is a prepositional phrase). He 
backed away from her (away is a particle, from her is a prepositional phrase). 

z N1 buy N2 describes a verb that takes a noun phrase object. 

Examples: He synthesized the enzyme. They like their neighbors. I found a key. 

z N1 give N2 to N3 describes a verb that takes a direct object and prepositional 
phrase. 

Examples: We gave it to them (it is the direct object, to them is a prepositional 
phrase). They took them from her (them is the direct object, from her is a 
prepositional phrase). She reminds me of you (me is the direct object, of you is a 
prepositional phrase). 

z N1 call N2 up describes a verb followed by a noun phrase and a particle (See Note 1 
below.) 

Examples: She sent it out. We looked them up. They brought it over. 

z N1 send N2 out to N3 describes a verb followed by a noun phrase, particle, and 
prepositional phrase. (See Note 2 below) 

Examples: We sent it out to them. She handed it over to me. I set them aside for her. 

z N1 say that . . . describes a verb that is a reporting verb, which is followed by a that-
clause. 

Examples: We said that he was right. They insisted that she was invited. I remember 
that the food was delicious. 

Note 1 

The particle appears after the noun phrase in these cases because the noun phrase is a 
pronoun. A particle must appear after the noun phrase if the noun phrase is a pronoun. If the 
noun phrase is not a pronoun, the particle may appear before the noun phrase, though in 
most cases it can appear after it also. Contrast these examples with their pronoun 
counterparts:  

Particle + Noun Phrase: She sent out the party invitation. 
Noun Phrase + Particle: She sent it out. 

Particle + Noun Phrase: We looked up the definitions. 
Noun Phrase + Particle: We looked them up. 

Particle + Noun Phrase: They brought over the new computer software. 
Noun Phrase + Particle: They brought it over. 

In some sentences a verb that is really a V + NP + part may look like V + prep + NP. The 
confusion arises when the sentence you have in mind for illustrating the verb contains an 
NP that is not a pronoun. For example: “He turned on the answering machine.” 

This sentence makes turn look like V + prep (on) + NP. But if you replace ‘the answering 
machine’ with it, you see that you must say, “He turned it on,” rather than, “He turned on 
it,” and therefore the verb is really V + NP + part. Compare this with the following sentence: 
“The car turned on the sidewalk.” You cannot say, “The car turned it on,” when substituting 
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it for the sidewalk, but instead must say, “The car turned on it.” Therefore the verb here is 
truly a V + prep + NP.  

Note 2 

In the following examples, the noun phrase right after the verb is a pronoun. If it were NOT 
a pronoun, you could reverse the order of the noun phrase and the particle. Compare the 
following sentences with their pronoun counterparts above:  

Particle + Noun Phrase: We sent out the order to them. 
Noun Phrase (pronoun) + Particle: She sent it out to them. 

Particle + Noun Phrase: She handed over the book to me. 
Noun Phrase (pronoun) + Particle: She handed it over to me. 

Particle + Noun Phrase: I set aside the files for her. 
Noun Phrase (pronoun) + Particle: I set them aside for her. 

For help distinguishing between particles and prepositions, especially when applying ‘N1 
call N2 up’ and ‘N1 send N2 out to N3’, see “About distinguishing between particles and 
prepositions” below. 

About distinguishing between particles and prepositions 

When selecting several of the verb types, you must decide whether the word accompanying 
a verb is a particle (part) or a preposition (prep). These parts of speech are small words in 
English: on, up, under, by, with, etc.  

Each of the following verb types contains a verb plus one or more types of small words: 

z N1 depend on N2 contains a preposition 

z N1 go out contains a particle 

z N1 put up with N2 contains a particle and preposition 

z N1 give N2 to N3 contains a preposition 

z N1 call N2 up contains a particle 

z N1 send N2 out to N3 contains a particle and preposition 

Because most particles in English also function as prepositions, and vice versa, it is 
sometimes difficult to decide whether a word is a particle or a preposition in a particular 
context. There are several differences between them. 

When deciding whether to choose a verb type with a preposition or particle, ask yourself 
the following questions:  

1. Can the small word move to the right and appear after the object noun phrase?  

If so, it is a particle, not a preposition. Prepositions in English only appear before a 
noun phrase. Particles are more like adverbs: they can move around. If you cannot 
move the word without destroying the meaning of the sentence, the word is a 
preposition. 
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Examples  

Original Sentence: He ran up a big hill. 
Try moving the word to the right: He ran a big hill up. 
Does that work? No. Moving up results in a poorly formed sentence. 
Therefore: Up is a preposition. 
Verb Type: N1 depend upon N2 

Original Sentence: He ran up a big bill. 
Try moving the word to the right: He ran a big bill up. 
Does that work? Yes. The meaning is the same. 
Therefore: Up is a particle. 
Verb Type: N1 call N2 up 

Original Sentence: She turned on the main road. 
Try moving the word to the right: She turned the main road on. 
Does that work? No. Moving on results in nonsense. 
Therefore: On is a preposition. 
Verb Type: N1 depend on N2 

Original Sentence: She turned on the lights. 
Try moving the word to the right: She turned the lights on. 
Does that work? Yes. The meaning is the same. 
Therefore: On is a particle. 
Verb Type: N1 call N2 up 

2. If the object noun phrase is a pronoun, must the small word appear after the 
pronoun?  

If so, it is a particle. If it must appear before the pronoun, it is a preposition. 

Examples:  

Original Sentence: We called her up. 
Try moving the word: We called up her. 
Does that work? No. Moving up results in a poorly formed sentence. 
Therefore: Up is a particle. 
Verb Type: N1 call N2 up 

Original Sentence: They shook it out. 
Try moving the word: They shook out it. 
Does that work? No Moving out results in a poorly formed sentence. 
Therefore: Out is a particle. 
Verb Type: N1 call N2 up 

Original Sentence: We walked up it. 
Try moving the word:. We walked it up. 
Does that work? No. Word must appear before the pronoun 
Therefore: Up is a preposition 
Verb Type: N1 depend on N2 
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3. When a sentence contains a verb + small word + noun phrase, and the noun 
phrase is not a pronoun, try replacing the noun phrase with a pronoun.  

 Must the small word now appear before or after the pronoun? 

If before, the word is a preposition. If after, the word is a particle. 

This rule can help you identify a Verb + Noun Phrase + Particle which, because of the 
word order, looks like a Verb + Preposition + Noun Phrase. 

Examples:  

Original Sentence: He turned on the answering machine. 
Replace NP with a pronoun: He turned it on.  
Where must the word go? After 
Therefore: On is a particle. 
Verb type: N1 call N2 up 

Original Sentence: The car turned on the sidewalk. 
Replace NP with a pronoun: The car turned on it. 
Where must the word go? Before 
Therefore: On is a preposition. 
Verb type: N1 depend on N2 

4. Do you stress the small word when you speak it? 

If so, it is a particle. If not, it is a preposition. 

Examples:  

Original Sentence: He turned in the driveway. 
Word stressed? No 
Therefore:. In is a preposition. 
Verb type: N1 depend on N2 

Original Sentence: He turned in the driver to the police. 
Word stressed? Yes 
Therefore:. In is a particle. 
Verb type: N1 send N2 out to N3 

Note that the following words are always prepositions, never particles: at, against, among, 
for, from, into, of, onto, toward, upon, with.  

The following are always particles, never prepositions: ahead, apart, aside, away, back, 
forth, forward, together.  

Some examples of common words which can be either particles or prepositions are across, 
along, around, behind, by, down, in, off, on, out, over, past, through, under, up. 
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About inflecting verbs  

� To generate the verb's inflection in the inflection boxes (Past, Past Participle, 3rd 
Person Singular, and Present Participle), click the Inflect button. Then edit the 
inflections to correct their spelling if necessary.  

When adding a verb followed by a particle or a preposition, you may want to enter 
inflections yourself rather than using the Inflect button to generate standard inflections. 

The button inflects the last word in the Base Form box. For example, if you generate 
standard inflections for send out, the result may be send outs, send outed, and send 
outing instead of the correct sends out, sent out, and sending out.  

To enter the Spanish translation for a verb (ES) 

After entering the English infinitive form of a verb, inflecting it, and choosing the verb type, do the 
following in the Spanish translation box:  

1. Enter the Spanish infinitive only (e.g., pintar, vender, salir) in the translation box.  

To translate an ‘N1 say (that)’ verb, do not include ‘que’ in the box; for example, enter 
only ‘pensar’ for think (that...). If the Spanish translation is a reflexive verb, include the 
se in the translation box. For example, for the English ‘N1 sleep’ verb coalesce, put ‘se 
unir’ in the box.  

English verb particles are never translated into Spanish. For example, the English ‘N1 
go out’ verb come in is translated into Spanish as ‘entrar’. The English ‘N1 call N2 up’ 
verb turn on as in, “She turned on the light,” is translated into Spanish as ‘encender’.  

Note that when the English verb has a preposition, its Spanish translation may or may 
not have one. Conversely, when an English verb does not have a preposition, its 
Spanish translation may have one or it may not.  

2. When the Spanish verb requires one or more prepositions, choose the correct ones 
from the list boxes that appear before the noun phrases that are their objects.  

Do not enter the preposition(s) in the translation box.  

Note the difference between the preposition a as in, “Envié el libro a mi madre,” and 
the personal a as in, “Vi a su hermana ayer” that marks certain (usually human) direct 
objects. The personal a should not be considered in deciding what prepositions a verb 
takes.  

Examples: 

When entering a translation for sail through, enter ‘navegar’ in the translation box and 
select ‘por’ in the list box.  

The English ‘N1 give N2 to N3’ verb consult on, as in, “We consulted John on the 
problem,” has one preposition, on, which comes before N3. Its Spanish translation 
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‘consultar’ has two prepositions, one before N2 and one before N3, as in,”Consultamos 
con Juan sobre el problema.”  

Examples of entering Spanish translations  

English verb type: N1 sleep 
How Spanish verb may differ: Neither E nor S has a preposition. 
Examples of Spanish translations: to walk (caminar). We will walk (Caminaremos). to 
scratch (se rascar). He scratched (Se rascó). 

English verb type: N1 depend on N2 
How Spanish verb may differ: Both E and S have a preposition before N2. 
Examples of Spanish translations: to rely on (depender (de)). We relied on Marisol 
(Dependíamos de Marisol). 

English verb type: N1 go out 
How Spanish verb may differ: Neither E nor S has a preposition. E has a particle, while 
S does not. 
Examples of Spanish translations: to go out (salir). We went out (Salimos). to fall down 
(caerse). I fell down: (Me caí). 

English verb type: N1 put up with N2 
How Spanish verb may differ: E has a particle; S does not. E has a preposition before 
N2; S may have one or not. 
Examples of Spanish translations: to blend in with (armonizar (con)). Its color blends 
in with the foliage (Su color armoniza con el follaje). put up with (aguantar). We put up 
with his behavior (Aguantamos su comportamiento). 

English verb type: N1 buy N2 
How Spanish verb may differ: E does not have a preposition; S may have one before 
N2, or not. 
Examples of Spanish translations: paint (pintar). I painted the deck. (Pinté la terraza.) 
to reach (llegar (a)). We didn't reach Boston until 2 in the morning. (No llegamos a 
Boston hasta las 2 de la mañana.) 

English verb type: N1 give N2 to N3 
How Spanish verb may differ: Both E and S have a preposition before N3. S may also 
have one before N2. 
Examples of Spanish translations: to badger for (importunar (por)). They badger their 
father for money. (Importunan a su padre por dinero.) Note that ‘a’ here is not a 
preposition, but the ‘personal a’.) to consult on (consultar (con) (sobre)). We consulted 
John on the problem. (Consultamos con Juan sobre el problema.) 

English verb type: N1 call N2 up 
How Spanish verb may differ: E has a particle; S does not. S may have a preposition 
before N2, or not. 
Examples of Spanish translations: to turn on (encender). I turned the lights on. 
(Encendí las luces.) to roll over (overturn): (dar la vuelta (a).) He rolled his car over/He 
rolled over his car: (Dio la vuelta a su automóvil.) 

English verb type: N1 send N2 out to N3 
How Spanish verb may differ: E has a particle, S does not. Both E and S have a 
preposition before N3. S may have one before N2 also, or not. 
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Examples of Spanish translations: to send out to (enviar (a)). We sent flyers out to our 
customers. (Enviamos folletos a nuestros clientes.) 

English verb type: N1 say that . . . 
How Spanish verb may differ: Neither E nor S has a preposition. E may or may not 
take 'that', while S always takes que. 
Examples of Spanish translations: to write (that) (escribir (que)). She wrote that they 
hadn't come. (Escribió que no habían venido.) to think (that) (pensar (que)). I think she 
is pretty. (Pienso que es bonita.) 

Entering Nouns, Adjectives and Prepositions 

To enter an English noun and Spanish translation (ES) 

1. Enter the singular form of the English noun in the Singular box.  

The noun you enter may consist of just one word, or of more than one. Examples: 
palmtop, cost of living, trade commission.  

2. Click the Inflect button to form the English plural, or enter it yourself in the 
Plural box.  

The Inflect button normally pluralizes the last word of the noun or noun phrase you 
enter. For example, if you entered key executive for the singular form, the Inflect button 
will produce key executives. If you enter reign of terror, it will produce reign of terrors, 
and you will need to correct this to reigns of terror.  

3. Enter the singular form of the Spanish translation in the Spanish Singular box.  

4. Enter the plural form of the Spanish translation in the Spanish Plural box.  

5. Select Masculine or Feminine from the Spanish Gender listbox.  

To enter an English adjective (EJ, ES) 

When you select Adjective as the part of speech, a drop-down list containing two items appears 
next to the Part of Speech list. Each item is an example of a different type of adjective. Select the 
item that best matches the adjective you want to add to the user dictionary.  

1. Choose Adjective in the Part of Speech listbox.  

2. Select the type of adjective you want to enter from the ‘like' listbox: 'N1 (that is) 
beautiful' or 'N1 (that is) fond of N2'.  

Choose ‘N1 (that is) beautiful’ when the adjective is a simple adjective, as in, “She is 
fearless,” or “That is an old house.”  
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Choose ‘N1 (that is) fond of N2’ when the adjective is followed by a prepositional 
phrase (preposition plus a noun phrase), as in, “He is good at tennis,” or “Be ready for 
dinner at 8:30.”  

Examples 

Simple Adjective: She is BEAUTIFUL. 
Adjective+Prepsotional Phrase: I am FOND OF her. 

Simple Adjective: The dog is SICK 
Adjective+Prepsotional Phrase: She is SICK OF school. 

Simple Adjective: Her face looked ANGRY. 
Adjective+Prepsotional Phrase: He is MAD AT his friend. 

Simple Adjective: The chemicals are HARMFUL. 
Adjective+Prepsotional Phrase: The chemicals are HARMFUL TO your body. 

3.  Enter the English form of the adjective in the Base Form box.  

The adjective you enter may consist of just one word, or of more than one. Examples: 
red, salty, average size, battle scarred.  

If you have chosen ‘N1 fond of N2,’ enter both the adjective (whether it is one word or 
more) AND the preposition in the Base Form box. Examples: tired of, terrific at, best 
known for, battle scarred from.  

To enter the Spanish translation for an adjective (ES) 

After entering the English adjective and selecting the adjective type, do the following in the 
Spanish translation box:  

1. Enter the masculine singular form of the Spanish translation in the Spanish 
Translation box.  

Do not include the preposition if there is one; it will be selected from a listbox in Step 4.  

1. Select which Spanish verb to be goes with the adjective by clicking on one of the 
four ‘To Be’ Form buttons. 

For example, She is talented would be translated with ‘ser’: ‘Es talentosa’, while He is 
tired would be translated with ‘estar’: ‘Está cansado. 

Some adjectives can be used with both to be verbs, in different situations. For a given 
adjective, you can choose whether ‘ser’ is more likely (as for ‘bueno’), or ‘estar’ is 
more likely (as for ‘sereno’).  

2. If you selected ‘N1 (that is) beautiful’ for the adjective type, choose Before Noun 
or After Noun from the Placement buttons. 

If the adjective precedes the noun, as in ‘a otra casa,’ click the Before Noun button.  

If it follows the noun, as in ‘la casa roja,’ click the After Noun button. 
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Note that all ‘N1 (that is) fond of N2’ adjectives follow the noun, so After Noun 
placement is automatic if you chose this type.  

3. Select one or more semantic features for N1 from its Features listbox.  

If you chose ‘N1 (that is) fond of N2’ for the adjective type, select features for N2 also, 
from its listbox. For example, talented (talentoso) refers mostly to people, as in a 
talented musician, so you would probably choose ‘human’ for the semantic feature for 
N1. 

Clogged with (atascado con), as in, “The street was clogged with vehicles,” or “The 
filter was clogged with leaves,” often has a place or a thing as N1, and virtually 
anything concrete as N2. You might choose ‘place’ and ‘entity’ for the features for N1 
and ‘entity’ for N2.  

For more information on semantic features, see Selecting Semantic Features below. 

4. If you selected ‘N1 (that is) fond of N2’ for the adjective type, choose the Spanish 
preposition that it takes from the listbox between N1 and N2.  

To enter an English preposition (EJ, ES) 

A sentence may have different meanings depending on whether a prepositional phrase has an 
adjectival or adverbial interpretation. For example, the sentence, “We need a book on the fourth of 
July,” means “We need a book about the American fourth of July holiday,” when on the fourth of 
July has an adjectival interpretation, but the same sentence means “On the fourth day of July we 
(will) need a book,” when the phrase has an adverbial interpretation.  

� To define an adverbial preposition, choose Adverbial from the drop-down list next 
to the Part of Speech list.  

Examples: “I saw him on the street.” “In her garden she found a gold coin.”  

� To define an adjectival preposition, choose Adjectival from the drop-down list 
next to the Part of Speech list.  

Examples: “The house on the hill burned down last night.” “He was in the kitchen 
earlier.”  
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Selecting Semantic Features (EJ, ES) 

Semantic features categorize the kinds of information for which the word is used. They improve 
translation by helping the system choose among competing translations. Translations that have 
matching or compatible semantic features receive preference. For example, in translating the 
sentence “The bank consolidated its reserves,” the system compares the available translations for 
“bank,” “consolidate,” and “reserves”. If one translation of each word has the semantic feature 
‘business’, that translation receives preference. The probability of using another translation of 
“bank”, with the semantic feature ‘natural object’ is decreased. 

Semantic features describe nouns and noun phrases. When you add a noun to a dictionary, you 
select semantic features that describe the noun itself. For example, if you are adding somebody’s 
name like John, you can assign the semantic feature ‘person's name’; if you are adding apple pie 
you can assign ‘food’; and when adding sadness, you can set its semantic features as ‘abstract’ 
and/or ‘state’. 

When you add a verb, adjective, or preposition, you select semantic features that describe the kinds 
of nouns and noun phrases that can appear in sentences with the word you are defining, such as, 
the subject of a verb or the noun phrase that follows a preposition. For example, when defining the 
verb pay, you can specify what pays as ‘human’ and/or ‘business’, as well as specifying what is 
paid as ‘money, asset’, or even more broadly, as ‘artifact’ and/or ‘substance’. When defining the 
preposition since, as in since last week, you can specify the object of the preposition as ‘time’. 

Adverbs and conjunctions do not have semantic features. 

The parts of a sentence that semantic features describe 

Refer to the templates that appear in the editor window when you have chosen a part of 
speech. A Features button is displayed under each part of the sentence for which you can 
select semantic features. Depending on the part of speech and type, you can choose 
semantic features for up to three different parts of the sentence. 

Except when describing a noun entry, the parts of the sentence you can describe with 
semantic features are noun phrases. The template identifies these phrases by number: N1, 
N2, and N3. For example, in the template ‘N1 <English Base Form> N2,’ N1 refers to 
whatever noun or noun phrase is the subject of the sentence and N2 refers to the object of 
the transitive verb. 

Note that the parts of the sentence may not be exactly the same in English and Spanish. For 
example, reach in English as in, “We reached Boston,” takes a place noun as a direct object, 
but it can be translated into Spanish by ‘llegar’, which calls for a preposition plus a place 
noun instead (Llegamos a Boston). 
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The following lists show each part of speech for which you can select semantic features and 
each part of the sentence that the features describe.  

z For a NOUN, select semantic features for the noun itself. 

z For a PREPOSITION, select semantic features for the noun phrase following the 
preposition. 

z For the VERB type N1 sleep, select semantic features for subject of verb. 

z For the VERB type N1 depend on N2, select semantic features for subject of 
verb...noun phrase following the preposition. 

z For the VERB type N1 go out, select semantic features for subject of verb . 

z For the VERB type N1 put up with N2, select semantic features for subject of 
verb...noun phrase following the preposition. 

z For the VERB type N1 buy N2, select semantic features for subject of verb...object 
of verb (or, in Spanish, sometimes the object of a preposition instead). 

z For the VERB type N1 give N2 to N3, select semantic features for subject of 
verb...object of verb (or, in Spanish, sometimes the object of another preposition 
instead)...noun phrase following the preposition. 

z For the VERB type N1 call N2 up, select semantic features for subject of 
verb...object of verb (or, in Spanish, sometimes the object of a preposition instead). 

z For the VERB type N1 send N2 out to N3, select semantic features for subject of 
verb...object of verb (or, in Spanish, sometimes the object of another preposition 
instead)...Noun phrase following the preposition . 

z For the VERB type N1 say that . . ., select semantic features for subject of verb. 

z For the ADJECTIVE type Beautiful, select semantic features for noun which the 
adjective describes. 

z For the ADJECTIVE type Fond of, select semantic features for noun which the 
adjective describes...noun phrase following the preposition 

To select semantic features 

You can select a single semantic feature for a word or multiple features. Or, you can have 
the translation system generate the information for you. 

As you fill in the English and translation fields, templates show how your word and its 
translation might appear in English and Japanese or Spanish sentences. A button below 
each noun phrase (N1, N2, or N3) in the Japanese or Spanish sentence lets you select the 
word's semantic features: the categories of information that are suitable for that phrase.  

Before selecting semantic features, you may find it helpful to refer to the template and 
imagine one or more actual sentences that match it.  
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1. Below the first noun phrase in the template, click Features.  

A Features dialog box for N1 appears.  

2. Select any check boxes that describe the first noun phrase for the word you are 
defining.  

The checkboxes are organized in a hierarchy. General features appear at the left and 
specific features are indented below them. The higher feature includes the lower feature, 
and specifying the higher feature applies the semantic features more broadly. For 
example, ‘person's name’ is included in ‘human’. 

To have the system generate semantic features, leave all the check boxes blank.  

3. Click OK to save your selections.  

To restore the most recently saved features, click Revert. 

When you want to uncheck all the boxes, click Clear All. 

4. Repeat from step 1 for each noun phrase in the template.  

Examples of semantic features 

If you are adding the verb say to, the English template might look like this: 

N1 will say N2 to N3. 

A Features button appears directly below N1, N2, and N3 in the Japanese and Spanish 
template. 

You might describe who will say by selecting ‘human’ in the Features dialog box for N1. 
You might describe what a human will say by selecting ‘statement’ for N2. Finally you 
might describe whom the human will say a statement to by ‘animate’ for N3. 

The following table describes examples of how each feature can be used. 
 

To describe things such as Select this semantic feature 

To have the system do it for you Don't select any features 

Any concrete object or substance Entity 

Any agent of action Animate 

Boy, she, wife, person, colleague Group, Human 

John, Juan, Smith, Yamada, Romero Person's name 

Government body, school, club, institute Organization 

Company, shop, factory, firm Business 

Tree, flower, weed, rose Plant 
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Any non-living, concrete thing Inanimate 

Cloud, planet, star, island, lake, mountain Natural Object 

Town, field, outside, country, sidewalk Place 

Cream, oil, liquid, solid, metal, poison, gas Substance 

Rice, dinner, ice cream, vegetable Food 

Statue, tool, furniture Artifact 

Memo, report, birth certificate, file Document 

Car, boat, bicycle, bus Vehicle 

Dollar, yen, mutual fund, stock, savings Money, asset 

Actions, ideas, states, attributes Abstract 

Things not covered by the other features Abstract 

Event, project, move, smile, jump Action 

Earthquake, storm, sunshine, gravity Natural phenomenon 

Peace, depression, situation, happiness, joy State 

Information, knowledge, art, thinking Cognition 

Attitude, plan, belief, principle  Mental object 

Computer program Mental object 

Story, language, music, song, play, statement Communication 

Oral utterance, report, question Statement 

Japanese, Spanish Language 

Week, vacation, pause Time 

Dozen, bunch, sum Quantity 
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Selecting Translation 
Options 

You set translation options by choosing “Translation Options” either from the Language Pair 
Chooser popup menu or from the Menu Bar. 

Because each set of translation languages has its own set of options, you must pick the desired 
languages first. If you are going to select a different translation engine (such as a new vendor or 
version) you should do that before changing the translation options.  

Note: For settings using the Dictionaries tab, please refer to Working with Dictionaries. 

Selecting the Translation Languages 

To set the languages of the source text and translation 

You set translation languages in each translation application separately. 

1. Open the translation application you want to use. 

In the Windows Start menu, look for LogoTrans, TransIt, or FileTrans under 
Programs/Language Engineering. 

In the application window, the Language Pair button shows the languages that are 
currently selected. For example, English to French translation appears as E¾F. 

 

3. Click the translation languages button in the main window and choose the new 
languages from the menu that appears.  

Your choice remains in effect until you change it. 

Describing the Source Text 

Translation options for some languages include an Input tab. Its options let you guide how the 
translation engine interprets the source text. 

To describe the Chinese language (CE) 

� Select the language in the Input tab: 
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z To translate Big5 encoded Traditional Chinese text (common in Taiwan and Hong 
Kong), select Traditional. 

z To translate GB encoded Simplified Chinese text (common in People's Republic of 
China), select Simplified. 

Make sure to use the right font to display the selected script. For example, you may 
want to pick the Ming Liu font to display Traditional Chinese, and MS Hei font to 
display Simplified Chinese. For more information on selecting fonts, see “To change 
the font and type size of text” in the chapter Changing the Display. 

To have the translation engine identify dialog (CE) 

� In the Input tab, check the Automatically Detect box. 

To describe the source text’s content (EJ, ES) 

Many words in the LEC dictionary have both a technical and a general, non-technical 
translation. For example, the verb engineer has the technical meaning ‘to design,’ as in “We 
engineered the new power plant,” and the non-technical meaning ‘to plan cleverly,’ as in 
“They engineered a takeover of their biggest competitor.” You can have the translation 
application favor either technical or general translations.  

� In the Input tab, select Technical or General. 

To translate the source text as dialogue (EJ, ES) 

English sentences that can have both vocative and non-vocative interpretations are 
ambiguous. For example, the sentence, “I’d like you to meet my friend, John,” can have 
two meanings:  

Vocative interpretation: John! I’d like you to meet my friend.  

Non-vocative interpretation: I'd like you to meet John, who is my friend.  

The translation applications are preset to rank non-vocative interpretations higher. When 
the text is a dialogue, the author is more likely to have intended vocative interpretations. In 
that case you can increase the likelihood that the translation will give preference to the 
vocative interpretation.  

� To interpret ambiguous sentences as dialogue, check the Dialogue box. 

Tuning the Translation 

Translation options for some languages include an Output tab. Its options let you guide how the 
translation engine generates the translation. 
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To identify the author’s gender (EF, EG, EI, EP) 

You can select the author gender in order to have the first person singular pronoun 1 
interpreted as feminine or masculine in the languages where this can make a difference in 
the translation of such other words in the sentence as past participles, adjectives, or 
predicate nominatives. For example, “I had left,” is translated into French as “J'_tais parti,” 
when the author is male, and as “J’_tais partie,” when the author is female. “I am sick,” is 
translated into Italian as “Sono malato,” when the author is male, and “Sono malata,” when 
the author is female. For German, the selection of author gender affects only predicate 
nominatives which have both masculine and feminine forms: “Ich bin Künstler,” for “I am 
an artist,” when the author is male, but “Ich bin Künstlerin,” when the author is female. 

� In the Author Gender box in the Output tab, select Female or Male. 
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To specify the audience (IE, PE, SE) 

� In the Output pane, select Direct or Indirect. 

Select direct when translating dialog. The setting determines the English translation of 
pronouns and possessive adjectives which are ambiguous between second person and 
third person. For example, in the Italian sentence, “Io le spedii una lettera,” le (her/you) 
will be translated as ‘you’ (I sent you a letter) when the audience is set to Direct, and as 
‘her’ when the audience is set to Indirect. The possessive adjective sua in the sentence 
“La sua famiglia _ qui?” will be translated as ‘your’ (Is your family here?) when the 
audience is set to Direct and as ‘his/her’ when it is set to Indirect. Similarly, selecting 
the audience will determine the translation of the ambiguous Portuguese words lhe 
(him/you), and seu or sua (their/your).  

To set the level of formality (EF, EG, EI, EP)  

When translating from English to French, German, Italian, or Portuguese, you can control 
the level of formality of your translation by selecting how the English you is translated. 

� In the Formality pane in the Output tab select Familiar, Familiar-Plural, Formal, 
or Formal-Plural. 

For example in German, select Familiar (‘du’), Familiar Plural (‘ihr’) or Formal 
(singular or plural) (‘Sie’) as the translation for English you. “Are you coming?” may 
thus be translated as “Kommst du?” or “Kommt ihr?” or “Kommen Sie?". In French 
you may choose between ‘tu’ and ‘vous’, in Italian among ‘tu’, ‘voi’, ‘Lei’, and ‘Loro’, 
and in Portuguese among ‘voc_’, ‘o senhor’, ‘a senhora’, ‘voc_s’, ‘os senhores’, and 
‘as senhoras’. 

To set the level of formality (EJ, EK) 

� Select in the Formality pane of the Output tab: 

z When translating Japanese select Informal (da), Polite (desu) or Formal (deanu). 

z When translating Korean select Informal or Polite. 

To set how ‘they’ and ‘them’ are translated (EJ) 

� In the Translate they, them pane of the Output tab, select whether to have plural 
third-person pronouns translated always as human, always as non-human, or 
whether to have the translation engine decide. 
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To set how proper nouns are translated (EJ) 

� In the Proper Nouns pane in the Output tab, select whether proper nouns should 
be retained in the source language, translated, or translated followed by the 
source language in parentheses. 

To set how numbers are represented (EJ) 

� In the Roman Characters pane in the Output tab, select whether numbers are 
retained unchanged (in Arabic numerals) or converted to single-byte or double-
byte characters. 

To set whether English ‘the’ is translated (EJ) 

� To translate the word ‘the’ as the Japanese word ‘sono’, select the Japanese 
Article check box. 

When the box is unchecked, ‘the’ is not translated at all. 

To set whether to translate English ‘you’ (EJ) 

� To include second person pronouns in the translation, select the Translate ‘you’ 
check box. 

To set how auxiliary verbs are translated (EJ) 

Auxiliary verbs in English include can, could, may, might, must, will, would, shall, should. 
You can change the translations used for these verbs and the translations used when they 
are combined with not or be.  

1. In the Output pane, click the Auxiliary Verbs button.  

A dialog shows the settings for each verb.  

4. For each verb: 

z To specify the translation yourself, select User Selection. 

z To use the default translation, select Automatic. 

The default translation for each verb is designated by an asterisk (*).  

3. When you choose User Selection for a verb, select your preferred translation for 
each of its variants from the list of alternate translations. 

4. When all of your selections are complete, click OK to return to the Output pane. 
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To identify incomplete translations (EJ, ES) 

When a sentence cannot be translated as a whole, it is translated in fragments, or word by word.  

� To mark in the translation where problems resulted in sentence fragments, select 
the Show GLOMs check box. 

To set how second-person pronouns are translated (ES) 

The Spanish words used for second person pronouns vary according to geographic region 
and according to the formality level chosen.  

The translation engine normally chooses the polite singular form ‘usted’ as the default 
pronoun, and inserts it between parentheses in the sentence. As a last step in working with a 
document, you will probably want to edit the Spanish text to remove the parentheses and 
the unwanted pronoun. 

You can also set the engine to use a different default pronoun: ‘t_’ or ‘vos’ instead of 
‘usted’. The Second Person Pronouns box in the Output tab allows you to set the regional 
variety of your preference. 

� In the Second Person Pronouns pane of the Output tab select Informal or Polite 
for your preferred regional dialect. 

You can select only one of the six settings. 

To set how imperatives are translated (ES) 

Imperative sentences in English use the same verb form for both singular and plural, 
whether speaking to one person or to several people. Spanish uses different verb forms and 
pronouns. You can adjust the Imperatives options to match the number according to the 
characteristics of each document.  

� In the Imperatives pane of the Output tab, select Singular or Plural. 

Imperatives works in conjunction with the setting for second-person pronouns. For 
example, different combinations of these settings can result in five different Spanish 
translations for the English imperative Come! 

If you select Singular in the Imperatives box and Informal, and General or Spain in the 
Second Person Pronouns box, the Spanish translation will be ‘_Ven!’. If you change 
the formality level to Polite instead of Informal, the translation will be ‘_Venga!’. If 
you check Voseo and Informal in the Second Person Pronouns box, the translation will 
change to ‘_Ven_!’.  

If you select Plural in the Imperatives box and General or Voseo is checked (in either 
the Informal or in the Polite register), the resulting translation will be ‘_Vengan!’, but 
if Spain and Informal have been selected, the translation will be ‘_Venid!’. 
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To set a default subject (JE, KE) 

Although Japanese sentences often lack subjects, English sentences require subjects. When 
the source Japanese does not have a subject, the translation engine tries either to guess the 
missing subject or to change the sentence structure to use the passive voice (depending on 
the settings of Handling of Missing Subject). You can specify a subject to be used when 
these attempts fail. 

� In the Output tab, choose a pronoun from the list in the Default Subject box. 

To set a default object (JE, KE) 

Assigning appropriate articles to English nouns is difficult when translating from Japanese 
to English because most Japanese nouns do not take articles. You can specify the article 
you want used as a default. 

� In the Output tab, choose an article from the list in the Default Object box. 

To specify how missing subjects are handled (JE, KE) 

Using a default subject can produce incorrect Japanese to English translations. Changing 
the sentence structure to use the imperative or the passive may be preferable. 

� In the Output tab, choose the  form  you prefer from among the following options: 

z Select Supplement to use the default subject you have selected. 

z Select Passive to translate the sentence in the passive voice. 

z Select None-Base to omit the subject and use a base infinitive verb (e.g., to be to 
go). 

z Select None-One to omit the subject and use a first person singular verb, (e.g., am, 
go) 

z Select None-Two to omit the subject and use a second person singular verb (e.g., 
are, go) 

z Select None-Three to omit the subject and use a third person singular verb (e.g., is, 
go). 

To use or not use English contractions (JE, KE) 

� In the Handling of Contractins area of the Output tab, choose Use (isn’t) when 
you want to permit the use of contractions in the translation. 

� Choose Do not use (is not) to prohibit the use of contractions. 
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Preserving HTML and Email Tags 

HTML documents, such as Web pages, contain codes, termed ‘Markup’, which instruct the 
browser how to display the page. When translating HTML documents, it is desirable to leave the 
markup untranslated than have Translate attempt to translate it. When you are using FileTrans or 
setting shared translation options, you can identify HTML documents, so that their markup is 
preserved in translation.  

When translating, email messages, you can also have Translate recognize and preserve the 
symbols that begin lines of quoted text.  

To describe markup in the source text 

1. Display the translation options and click the Markup tab. 

2. If you are translating email messages which may contain symbols for quoted text, 
check the ‘Recognize email prefix quoting’ check box. 

If you have opened the shared translation options or the translation options from within 
FileTrans, two additional options appear in the Markup tab. 

3. In the shared or FileTrans translation options, select whether you want the 
document translated as a plain text file (no markup) or HTML file. 

Setting the Speed of Translation 

To balance translation accuracy and speed (EJ, ES) 

 

Accuracy and speed are related. More accurate translations take more time and require 
more memory. Faster translations may be less accurate. Normally the translation engine 
balances speed against accuracy to provide good translations in a reasonable length of time 
and, when memory is limited, uses the most accurate setting that available memory allows.  

� In the Speed tab, choose a setting from the Accuracy Versus Speed pull-down list.  

The current setting is shown in the box.  

Best (at the bottom of the list) produces the most accurate translations. At this setting, 
the engine considers every possible interpretation of each English sentence and selects 
the best one.  

Fastest (at the top of the list) produces the most rapid translations. At this setting, the 
program considers fewer possibilities. 

Greater accuracy requires more memory. When translating an unusually long or 
complex sentence with a setting toward the Best end of the scale, insufficient memory 
may result in a less accurate or word-by-word translation. If you see many word-by-
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word translations at a given setting, try using a faster setting or increase the available 
memory.  

  


